Late Breaking News for HP Web Jetadmin 10.4 SR8

Readme
# Table of contents

1 Late Breaking News for HP Web Jetadmin 10.4 SR8 (Edition 45, 07/2020) ................................................................. 1

HP Web Jetadmin 10.4 SR8 (10.4.110231) .................................................................................................................. 2
HP Web Jetadmin installation and upgrade .................................................................................................................. 3
   Back up the HP Web Jetadmin installation and database before running an installation or upgrade .......................... 3
   Upgrade HP Web Jetadmin when the HPWJA service runs as a user account ......................................................... 3
What’s new in HP Web Jetadmin 10.4 SR8 (10.4.110231) ....................................................................................... 5
New supported devices for HP Web Jetadmin 10.4 SR8 (10.4.110231) ................................................................. 8
Improvements and fixes in HP Web Jetadmin 10.4 SR8 (10.4.110231) ............................................................... 10
Known issues .............................................................................................................................................................. 12
HP Web Jetadmin release history (partial) ................................................................................................................ 14
Universal Plug-ins release history ............................................................................................................................. 16
   Enterprise Class UPIs ........................................................................................................................................ 16
   Distributed Enterprise Class UPIs ......................................................................................................................... 20
   Fleet Monitoring Class UPIs .............................................................................................................................. 22
   HP ScanJet UPI ................................................................................................................................................ 22
   Samsung UPIs ............................................................................................................................................... 23
   ZTC for Zebra devices UPI ............................................................................................................................... 24
   Other plug-ins ................................................................................................................................................. 25
Improvements and fixes in previous Service Releases of HP Web Jetadmin .......................................................... 29
   HP Web Jetadmin 10.4 SR7 (10.4.109068) ........................................................................................................... 29
   HP Web Jetadmin 10.4 SR6 (10.4.106526) ......................................................................................................... 30
   HP Web Jetadmin 10.4 SR5 (10.4.105723) ......................................................................................................... 31
   HP Web Jetadmin 10.4 SR4 (10.4.104106) ......................................................................................................... 33
   HP Web Jetadmin 10.4 SR3 (10.4.103287) ......................................................................................................... 35
   HP Web Jetadmin 10.4 SR2 (10.4.101995) ......................................................................................................... 36
   HP Web Jetadmin 10.4 (10.4.99821) .................................................................................................................. 40
   HP Web Jetadmin 10.4 (10.4.98174) .................................................................................................................. 41
   HP Web Jetadmin 10.3 SR8 (10.3.96073) ........................................................................................................... 43
   HP Web Jetadmin 10.3 SR7 (10.3.93994) ........................................................................................................... 44
   HP Web Jetadmin 10.3 SR6 (10.3.93671) ........................................................................................................... 45
   HP Web Jetadmin 10.3 SR5 (10.3.91358) ........................................................................................................... 47
1 Late Breaking News for HP Web Jetadmin 10.4 SR8 (Edition 45, 07/2020)

- HP Web Jetadmin 10.4 SR8 (10.4.110231)
- HP Web Jetadmin installation and upgrade
- What's new in HP Web Jetadmin 10.4 SR8 (10.4.110231)
- New supported devices for HP Web Jetadmin 10.4 SR8 (10.4.110231)
- Improvements and fixes in HP Web Jetadmin 10.4 SR8 (10.4.110231)
- Known issues
- HP Web Jetadmin release history (partial)
- Universal Plug-ins release history
- Improvements and fixes in previous Service Releases of HP Web Jetadmin
- Improvements and fixes in previous Feature Pack releases of HP Web Jetadmin

This document addresses HP Web Jetadmin 10.4 SR8 (10.4.110231). For a list of HP Web Jetadmin releases, see HP Web Jetadmin release history (partial) on page 14.

This document is a supplement to the online Help and the HP Web Jetadmin 10.4 Installation and Setup Guide. The Late Breaking News for HP Web Jetadmin 10.4 is updated occasionally. The current edition is available from the HP Web Jetadmin support page (in English).

HP Web Jetadmin might not be localized at every software release. If a software release is not localized, some of the new and updated content in the software and online Help for that release might be displayed in English while other content is displayed in the language that is specified by the Region and Language settings on the client that is used to access HP Web Jetadmin.
HP Web Jetadmin 10.4 SR8 (10.4.110231)

HP Web Jetadmin 10.4 SR8 (10.4.110231) includes improvements and fixes, as well as support for new HP devices. For more information, see Improvements and fixes in HP Web Jetadmin 10.4 SR8 (10.4.110231) on page 10.

This release supersedes previous releases of the software (see HP Web Jetadmin release history (partial) on page 14). This is a cumulative release. All improvements, fixes, and device support in previous releases are also included in this release.

This version is installed by using the installation executable.

Upgrading from earlier releases of HP Web Jetadmin can be slow depending on the settings and data that are in place on the system that is being upgraded and on system performance. After the HP Web Jetadmin installer is finished and the HPWJA Service starts, upgrade routines in the HPWJA Service run and act on the existing HP Web Jetadmin data. The time that it takes for these routines to finish can vary greatly. Do not interrupt the HPWJA Service during or after an upgrade. The client logo screen that starts every time the HP Web Jetadmin client is launched displays a message if an upgrade is running.

⚠️ WARNING! During upgrade of HP Web Jetadmin 10.4 SR4 or older, the existing configuration item Access Control for Device Functions is changed into Access Control for Device Functions for FutureSmart 3. New configuration templates for FutureSmart 4 devices must be created with the new configuration option: Access Control for Device Functions for FutureSmart 4.

To access the support documentation, including white papers, go to the HP Web Jetadmin support page. For the most current information about installation and setup, review the HP Web Jetadmin 10.4 Installation and Setup Guide on the support page.

⚠️ IMPORTANT: HP only tests and supports upgrades for three versions earlier. If the current version you are using is more than three versions earlier, perform the upgrade in more than one step.
HP Web Jetadmin installation and upgrade

Back up the HP Web Jetadmin installation and database before running an installation or upgrade

If you are using a local SQL server, use the backup and restore scripts that are available in the following directory:

C:\Program Files\Hewlett-Packard\Web Jetadmin 10\WJABackupRestore

After an upgrade, this directory changes to the following:

C:\Program Files\HP Inc\Web Jetadmin 10\WJABackupRestore

If you are using a remote SQL database, back up the SQL database with the SQL-specific backup options.

The HP Web Jetadmin installer verifies that the Microsoft .NET Framework and Microsoft Windows Installer components are installed. If these components are not already installed, the installer stops running and notifies the user. The installer might also request a reboot depending on the state of the system at installation time.

To download .NET Framework 4.5 or later, go to the Microsoft .NET Framework web site. Click Downloads, and then navigate to the version of .NET Framework that you need to install.

To download Microsoft Windows Installer 4.5, go to the Microsoft Download Center, and then search for the keywords Windows Installer 4.5. Click the Windows Installer 4.5 Redistributable link, and then follow the instructions to download and install the file that is appropriate for your operating system version and platform.

The HP Web Jetadmin installer performs extensive disk space checking and provides an option to redirect the installer to place either the Microsoft SQL Server instance files and directories or the HP Web Jetadmin installation directories in alternate directory paths.

For non-English operating systems or English operating systems that have the Format set to non-English, HP Web Jetadmin can be started in English-only by browsing to the following URL: http://<ip_address>:8000/wja/wja.application?lang=en-us. This is very useful for obtaining the latest online Help for HP Web Jetadmin because updates for the localized online Help are not provided with every release.

If the HP Web Jetadmin service runs as a network service, start the upgrade process now. If the HP Web Jetadmin service runs as a user account, follow the instructions in the next section to prevent data loss.

Upgrade HP Web Jetadmin when the HPWJA service runs as a user account

When the HP Web Jetadmin service runs as a user account instead of a network service, use the following steps to upgrade HP Web Jetadmin:

2. Back up the current HP Web Jetadmin installation. The WJABackupRestoreInstructions_<language_code>.txt file provides instructions for backing up HP Web Jetadmin. This file is located in the following directory on the HP Web Jetadmin server:

   C:\Program Files\HP Inc\Web Jetadmin 10\WJABackupRestore

3. In HP Web Jetadmin, go to Help > About, and then write down the current version as 10.4.nnnn (10.4 SRX), where nnnn is the build number and X is the version. This information is required to perform a recovery.

4. Go to Application Management > Overview > Application Management – Active Tasks, and then check for any paused or pending tasks. You must stop or resolve these tasks before you run the installer.
5. In HP Web Jetadmin, export the device configuration templates. Use the following file name:
   ExportedTemplates_WJARunningAsUser_WJAversion10.4srX (where X is the HP Web Jetadmin version noted in step 3)

6. If there are other templates, such as discovery or alerts, that are configured with passwords, export those templates to files with file names similar to the file name in step 5.

7. Change the HP Web Jetadmin service to run as a network service.


10. Import the templates you exported in steps 5 and 6. Be sure to select the **Overwrite duplicate templates** check box.

11. Run the installation executable on the system that hosts HP Web Jetadmin.

12. In HP Web Jetadmin, export the device configuration templates. Use the following file name:
   Exported Templates_WJARunningAsNetworkService_WJAversion 10.4srY (where Y is the version of the upgrade just installed)

13. If there are other templates, such as discovery or alerts, that are configured with passwords, export those templates to files with file names similar to the file name in step 12.

14. Change the HP Web Jetadmin service to run as a user account.

15. Restart the HP Web Jetadmin service. The HP Web Jetadmin client automatically closes.


17. If any of the original XTP tickets are missing, import the XTP tickets.

**NOTE:** If XTP tickets were installed and HP Web Jetadmin was running as a user account before you started the upgrade, all the XTP tickets installed during the upgrade are missing when the HP Web Jetadmin service runs as a user account.

18. (Optional) Install the additional XTP tickets that are included with the current Feature Pack and are only available when the HPWJA service runs as a network service. The XTP tickets that are prebundled with the Feature Pack are not available when HP Web Jetadmin runs as a user account. You must import these XTP tickets one at a time. To obtain a ZIP file that contains all the prebundled XTP tickets, go to [http://www.hp.com/go/webjetadmin](http://www.hp.com/go/webjetadmin), click **Download now**, and then click **Select**. Follow the instructions.

19. Import the templates that you exported in steps 12 and 13.

20. Add the global credentials again.

21. Verify that the correct settings are in the templates and the templates are working.
What's new in HP Web Jetadmin 10.4 SR8 (10.4.110231)

HP Web Jetadmin 10.4 SR8 (10.4.110231) includes the following new features:

1. CR 12651: For the **Outgoing Servers** configuration option in the **Device** category, the **Enable SMTP SSL/TLS Protocol** check box is now available.

2. CR 12728: The following XTP tickets have been added:
   - FollowMe_RevisionVersion_ReadOnly_FS
   - Default_Print_Output_Bin_ReadWrite_FS
   - SupportedKey_Readonly_FS

3. CR 12834: For the **Wireless Station (802.11)** configuration option in the **Wireless** category, HP Web Jetadmin now supports variable data for the **User name** and **Server ID** field in the **WPA-Enterprise** setting.

4. REQ 7284: For the **Secure Communication** configuration option in the **Security** category, the following ciphers have been added:
   - DHE-RSA-AES256-GCM-SHA384
   - DHE-RSA-AES256-SHA256
   - DHE-RSA-AES256-SHA
   - DHE-RSA-AES128-GCM-SHA256
   - DHE-RSA-AES128-SHA256
   - DHE-RSA-AES128-SHA

5. REQ 7379: For Samsung devices, such as the MX4 and MX7, HP Web Jetadmin supports new alerts and alert codes on the **Status** tab.

6. REQ 7389: The new **Automatic Firmware Update** configuration option in the **Firmware** category is supported for FutureSmart 4.11 and later.

7. REQ 7390: The new **Directed Update Create** and **Directed Update Status/Actions** configuration options in the **Firmware** category are supported for FutureSmart 4.11 and later.

8. REQ 7395: A device image for the HP LaserJet M609 series has been added.

9. REQ 7462: The self-signed certificate for HP Web Jetadmin has been updated.

10. REQ 7467: For Samsung devices, such as the MX4 and MX7, HP Web Jetadmin now supports the **Print Usage Counters** column in device lists.

11. REQ 7480: For Samsung GV device models—such as the C3010, M4530, C4010, C3060, K3300, and X3280—HP Web Jetadmin now supports **Device Cloning**.

12. REQ 7482: For Samsung devices, such as the MX4 and MX7, HP Web Jetadmin now supports **Device Utilization - Media Size (Default)** reports.

13. REQ 7140: HP Web Jetadmin no longer requires Microsoft .NET 3.5.x.


16. REQ 7353: HP Web Jetadmin is able to read Total Accent Color and Full color for devices such as HP PageWide pro MFP M772dn.

17. REQ 7366: The Print Usage Counters column is supported for the HP PageWide XL/HP DesignJet 6+Colors (MFP) UPI.

18. REQ 7402: HP ePrint and HP Web Services have been added to the Web Services category for the HP DesignJet NIC 4 Colors and HP PageWide XL/HP DesignJet NIC 6+ Colors UPI.

19. REQ 7413: Added the configuration options IP Fax - SIP Server Settings under the Fax category for the HP Enterprise MFP UPI and added IP Fax settings to the existing Fax Send Settings configuration option under the Fax category for the HP Enterprise MFP UPI.

20. REQ 7414: Added configuration option IP Fax - Gateway Settings and added IP Fax settings to the existing Fax Receive Settings configuration option under the Fax category for HP Enterprise MFP UPI.

Feature Pack 13 (version 1.13.110232) includes the following new features and fixes:

NOTE: See Improvements and fixes in previous Feature Pack releases of HP Web Jetadmin on page 69 for new functionality that has been added with previous feature packs.

- CR 12587: For the HP PageWide Pro MFP 772–777z and HP PageWide MFP P77740–60zs devices, additional paper sizes have been added to the Default Media Size configuration option in the Device category. This change was made in the HP PageWide Pro/Officejet Pro MFP UPI.

- CR 12650: For the HP PageWide Pro MFP 772–777z and HP PageWide MFP P77740–60zs devices, the Content Orientation, Reduce/Enlarge, and Original Size settings have been added to the Quick Sets configuration option in the Device category. This change was made in the HP PageWide Pro/Officejet Pro MFP UPI.

- CR 12671: If a device cannot be reached after it is restarted, the device status now temporarily changes to Device Communication Error.

- CR 12728: The following XTP tickets have been added:
  - FollowMe_RevisionVersion_ReadOnly_FS
  - Default_Print_Output_Bin_ReadWrite_FS
  - SupportedKey_Readonly_FS

- CR 12789: For the Default Print Options configuration option in the Device category, the Alternate bin option has been added to the Output Bin drop-down list.

- CR 12797: The Firmware category for device configuration options has been added. The new Automatic Firmware Update, Directed Update Create, and Directed Update Status/Actions configuration options are included in this category.

- CR 12825: For the Fax Receive Settings configuration option in the Fax category, values of 1 through 6 are now supported for the Rings to answer field.

- REQ 7389: The new Automatic Firmware Update configuration option in the Firmware category is supported for FutureSmart 4.11 and later.

- REQ 7390: The new Directed Update Create and Directed Update Status/Actions configuration options in the Firmware category are supported for FutureSmart 4.11 and later.
● REQ 7395: A device image for the HP LaserJet M609 series has been added.

● REQ 7447: The **Quality and Speed** configuration option in the **Device** category now supports enabling and disabling HP High Speed mode.

● REQ 7447: The **Secure Communication** configuration option in the **Security** category now supports new ciphers.
New supported devices for HP Web Jetadmin 10.4 SR8 (10.4.110231)

HP Web Jetadmin 10.4 SR8 (10.4.110231) added support for the following devices:

- HP Color LaserJet Flow E77830
- HP Color LaserJet M555
- HP Color LaserJet Managed MFP E78228
- HP Color LaserJet MFP M578
- HP Design Jet T650 24-in
- HP Design Jet T650 36-in
- HP Laser 408
- HP Laser MFP 432
- HP LaserJet M209dw
- HP LaserJet M612
- HP LaserJet Managed MFP E77422
- HP LaserJet Managed MFP E77428
- HP LaserJet Managed MFP E77822
- HP LaserJet Managed MFP E77823
- HP LaserJet Managed MFP E77825
- HP LaserJet Managed MFP E77830
- HP LaserJet Managed MFP E78223
- HP LaserJet Managed MFP E78228
- HP LaserJet Managed MFP E78323
- HP LaserJet Managed MFP E78325
- HP LaserJet Managed MFP E78330
- HP LaserJet MFP M234dw
- HP LaserJet MFP M635

Device updates are installed by using the HP Web Jetadmin installer. An updated installer is released periodically to provide new device support and defect fixes. You can run the installer on any earlier version of HP Web Jetadmin. If the devices that an update targets were discovered prior to running the installer, you must re-register the devices. The installer does not automatically re-register the devices as part of the upgrade. To re-register the devices, perform one of the following steps:

- Right-click anywhere on a device list, and then select Refresh Selection (Full).
- Run a discovery using any of the discovery methods except Quick Device Discovery.
For a list of all of the devices that HP Web Jetadmin supports, see the *HP Web Jetadmin 10.4 Supported Devices Readme*. This document is available from the HP Web Jetadmin [support page](#) (in English).
Improvements and fixes in HP Web Jetadmin 10.4 SR8 (10.4.110231)

HP Web Jetadmin 10.4 SR8 (10.4.110231) includes the following improvements and fixes:

1. CR 12546: When installing solutions on devices, the **Activate Choice of Solution** button on the **Settings** page of the **Install Solutions** wizard has been renamed to **Activate Settings for Solutions**. After the **Activate Settings for Solutions** button is clicked, the button name changes to **Settings for Solutions Activated**.

2. CR 12563: HP Web Jetadmin now updates the version of the remote server for synchronization when the server has been upgraded.

3. CR 12666: After upgrading HP Web Jetadmin, device models no longer show **<Unknown>** on the **Status** tab.

4. CR 12708: When you add a filter for a device list and select **Jetdirect Model** from the **Device Property** drop-down list, the **Value** drop-down list now contains a list of the HP Jetdirect device models that HP Web Jetadmin supports.

5. CR 12714: After upgrading to HP Web Jetadmin 10.4 SR8, random character entries are no longer shown in the **Application Name** column in the **Home Screen Applications - FutureSmart 3** configuration option.

6. CR 12715: For Samsung devices, the **Print Sheet Counters** column in device lists now shows correctly.

7. CR 12717: HP Web Jetadmin no longer removes the home screen application icons on the device when the application is marked as **keep-as-is** for the **Home Screen Applications - FutureSmart 4** configuration option in the **Device** category.

8. CR 12721: After performing a backup and restore of HP Web Jetadmin, the **Firmware Repository** is no longer empty.

9. CR 12726: For the **Control Panel Display** configuration option in the **Device** category, a warning has been added saying that some printers maintain this information in volatile memory and this information might be removed during a device reboot.

10. CR 12737: For the **Outgoing Servers** configuration option in the **Device** category, variable data can now be entered in the **Server name or address** field.

11. CR 12740: HP Web Jetadmin now shows the correct value for the **Total Other Color Impressions** column in device lists.

12. CR 12757: For the **Tray Administration** configuration option in the **Device** category, HP Web Jetadmin now provides the paper types.

13. CR 12764: For mono FutureSmart devices, the **Restrict Color** column in device lists now shows **<Not supported>**.

14. CR 12770: When creating a device configuration template, the **Load Email Quick Set** option is now available for the **Access Control for Device Functions - FutureSmart 4** configuration option in the **Security** category.

15. CR 12782: For the HP Designjet T2600 series plotters, all of the supplies information is now available in HP Web Jetadmin.

16. CR 12783: HP Web Jetadmin can now import user-defined fields for third-party devices.

17. CR 12785: When creating a Quick Set for Email, variable data can now be entered in the default **From** field.

18. CR 12791: The Samsung K4355 device can now be upgraded.

19. CR 12792: The actual fax number now shows on reports instead of **<Not supported>**.
20. CR 12793: The UI strings in InstallShield for Russian, Japanese, and Chinese are now aligned.

21. CR 12796: When configuring the Access Control for Device Functions - FutureSmart 4 option in the Security category, the HP Web Jetadmin client no longer crashes.

22. CR 12801: For some devices, such as the HP Color LaserJet Pro MFP M477 series, HP Web Jetadmin now displays the correct model name and a status of Ready in device lists instead of displaying <Unknown> and a status of Device Communication Error.

23. CR 12806: For the HP LaserJet Enterprise M609 series devices, HP Web Jetadmin now displays <Not supported> instead of <Invalid data> when you configure the Secure File Erase Mode configuration option in the File System category.

24. CR 12822: For the HP LaserJet Pro M404dw device, HP Web Jetadmin now supports the WPA-Enterprise setting for the Wireless Station (802.11) configuration option in the Wireless category.

25. CR 12824: If SNMPv1/v2 is set to read-only on the device, HP Web Jetadmin now asks for the SNMP write credential when changes to the IPv4 Information configuration option in the Network category are applied.
Known issues

The HP Web Jetadmin software teams are addressing the following known issues. For more information about fixes and product enhancements in future releases of HP Web Jetadmin, check this document regularly or use HP Subscriber’s Choice Alerts on www.hp.com.

1. CR 12761: For Wi-Fi connected HP LaserJet Pro and HP Officejet Pro products, if the status of a data collection is Device Change Error, HP Web Jetadmin will not generate the report.

2. CR 12812: If HP Web Jetadmin receives multiple Instant On messages from HP JetAdvantage Security Manager in a very short time period, the HP Web Jetadmin services might crash.

3. CR 12829: When the FutureSmart Bundle Version XTP ticket is added as a user-defined configuration option, and then added to a device list as a column, the values are sorted incorrectly.

4. CR 12858: For the HP LaserJet Pro M404dw printer, the WPA Version setting in the Wireless Station (802.11) configuration option in the Wireless category is always set to Auto even though HP Web Jetadmin shows the result as a success for other values, such as WPA and WPA2.

5. CR 12194: Expanding device categories can be slow if the device category contains feature pack configuration settings. This issue is under investigation.

6. REQ 7381: It is not currently possible to use HP Web Jetadmin to upgrade the firmware on Samsung devices that use an *.hd firmware file. This functionality might be added in a future release.

7. CR 12556: After clicking HP Support Page on the Troubleshooting tab, the HP Support page format is displayed incorrectly.

8. CR 12591: For IWS PC-connected devices, the Access Control for Device Functions - FutureSmart 3 and Non-FutureSmart devices configuration option results in an error.

9. CR 12627: Counters are not increased for General Office Color and Accent Color in Print usage Counters for HP PageWide Pro 452 devices. This is a firmware issue.

10. CR 12638: Configuration changes made with HP Web Jetadmin on DesignJet devices for ePrint are not retained on the device, although the configuration ends in success in HP Web Jetadmin. This is a firmware issue.

11. CR 11782/REQ 7092: Quick device discovery of Samsung K7600 printer is slow.

12. HP Web Jetadmin does not display all of the solutions that are installed on HP FutureSmart devices on the Solutions tab if the solution was not installed with HP Web Jetadmin, even if the solutions are displayed on the General tab in the device HP Embedded Web Server (EWS).

Workarounds: Use one of the following options to resolve this issue:

– Use HP Web Jetadmin to reinstall the solution on the device. For more information, see the OXPd Solution Installer in HP Web Jetadmin white paper. This white paper is available from the HP Web Jetadmin support page.

– Most solutions are used with a Home screen application. To display the installed solutions for HP FutureSmart devices, create an automatic group with filters for the solution’s Home screen application. For example, the following is the filter for a Home screen application called NSE Scanner:

```
AnyItem([Home Screen Applications.All Apps], [EQ([Item.Application Title\], \[NSE Scanner\]))])
```

Map the required XTP read ticket to a user defined field to display the version or date of the installed solution. The required XTP ticket is solution specific, for example, use the XTP ticket
13. Device Utilization by User data collections are resource-intensive and reduce printing speed. Therefore, Device Utilization by User data collections should be enabled only sparingly.

**NOTE:** The HP OfficeJet Pro X476 MFP and HP OfficeJet Pro X576 MFP devices do not support the Device Utilization by User data collection type.

14. For HP OfficeJet Pro devices, such as the HP OfficeJet Pro 251 and HP OfficeJet Pro X476, if a password is set by using the HP Embedded Web Server (EWS) on the device and then the password is removed by using the EWS on the device, HP Web Jetadmin continues to prompt for credentials when other options are configured.

15. **Issue:** When applying device configuration templates that contain a large number of settings, such as more than 60 Quick Sets, a timeout might occur.

   **Workaround:** To prevent these timeouts, perform the following steps:
   
a. Open the \HP.Imaging.Wjp.Communication.Protocol.Web.Services.ITransfer.config file in Notepad or a similar text editor. This file is available from the following directory: C:\Windows\ServiceProfiles\NetworkService\AppData\Local\HP Inc\HP WebJetadmin\WjaService\config.
   b. Increase the timeout interval from 60 seconds to 120 or 180 seconds.
   c. Close and save the XML file.

16. The Fax Send Setting configuration option does not work for PC-connected HP OfficeJet Pro 8600 Series and HP OfficeJet Pro 8500A devices.

17. CR 12441: The Task Module docking area is displayed with English text or with question marks instead of Chinese text when starting HP Web Jetadmin client in Chinese.

   **Workaround:** remove the Task Module docking area (by clicking on the cross) and re-add this (under View > Task Modules).

18. CR 12322: Expanding different categories with service pack only configuration items for devices that use the HPWS Pro adapter is now faster. See also known issues 12194.


   **Workaround:** Increase the SNMP timeout (double or triple this value).

20. CR 12724: While upgrading firmware from HP Web Jetadmin for Samsung devices, when the EWS credentials have been set on the devices, Error is displayed at the end of configuration.

   **Workaround:** Add EWS credentials to Global Credentials (under Tools > Options > Shared > EWS) or right-click on the device, select Update Credentials, and then enter credentials.
<table>
<thead>
<tr>
<th>Release name</th>
<th>Version/build</th>
<th>Release date</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Web Jetadmin 10.4 SR8</td>
<td>10.4.110231</td>
<td>10-July-2020</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR7</td>
<td>10.4.109068</td>
<td>12–December–2019</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR6</td>
<td>10.4.106526</td>
<td>20–June–2019</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR5</td>
<td>10.4.105723</td>
<td>28–January–2019</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR4</td>
<td>10.4.104106</td>
<td>3–May–2018</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR3 (update 1)</td>
<td>10.4.103287</td>
<td>29-November–2017</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR3</td>
<td>10.4.103054</td>
<td>16-November–2017</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR2 (update 2)</td>
<td>10.4.101995</td>
<td>23-June–2017</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR2 (update 1)</td>
<td>10.4.101899</td>
<td>26-May–2017</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR2</td>
<td>10.4.101715</td>
<td>28-April–2017</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR1 (re-release)</td>
<td>10.4.99821</td>
<td>22-July–2016</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4 SR1</td>
<td>10.4.99186</td>
<td>28-April–2016</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.4</td>
<td>10.4.98174</td>
<td>28-October–2015</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 SR8</td>
<td>10.3.96073</td>
<td>25-January–2015</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 SR7</td>
<td>10.3.93994</td>
<td>23-July–2014</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 SR6</td>
<td>10.3.93671</td>
<td>16-May–2014</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 SR5</td>
<td>10.3.91358</td>
<td>10-January–2014</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 SR4</td>
<td>10.3.90613</td>
<td>23-October–2013</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 SR3</td>
<td>10.3.88120</td>
<td>1-June–2013</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 SR2</td>
<td>10.3.86392</td>
<td>30-January–2013</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 SR1</td>
<td>10.3.85669</td>
<td>26-November–2012</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.3 (initial release)</td>
<td>10.3.83654</td>
<td>11-July–2012</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 SR7</td>
<td>10.2.80493</td>
<td>20-January–2012</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 SR6</td>
<td>10.2.77156</td>
<td>9-August–2011</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 SR5 Hotfix 1</td>
<td>10.2.74918</td>
<td>11-March–2011</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 SR5</td>
<td>10.2.73942</td>
<td>18-February–2011</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 SR4</td>
<td>10.2.71771</td>
<td>15-November–2010</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 SR3</td>
<td>10.2.66860</td>
<td>2-June–2010</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 SR2</td>
<td>10.2.63313</td>
<td>12-February–2010</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 SR1</td>
<td>10.2.62227</td>
<td>25-November–2009</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 Hotfix 1</td>
<td>10.2.59093</td>
<td>20-July–2009</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.2 (initial release)</td>
<td>10.2.58560</td>
<td>6-July–2009</td>
</tr>
<tr>
<td>Release name</td>
<td>Version/build</td>
<td>Release date</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.1 SR3</td>
<td>10.1.58563</td>
<td>6-July-2009</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.1 SR2</td>
<td>10.1.56108</td>
<td>16-February-2009</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.1 Hotfix 1.5</td>
<td>10.1.55407</td>
<td>16-January-2009</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.1 SR1.5</td>
<td>10.1.54718</td>
<td>15-December-2008</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.1 SR1</td>
<td>10.1.54718</td>
<td>24-October-2008</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.1 Hotfix</td>
<td>10.1.53182</td>
<td>3-October-2008</td>
</tr>
<tr>
<td>HP Web Jetadmin 10.1 (initial release)</td>
<td>10.1.52747</td>
<td>22-September-2008</td>
</tr>
</tbody>
</table>
Universal Plug-ins release history

When HP Web Jetadmin 10.3 SR4 was released, Universal Plug-ins (UPIs) were introduced to support the majority of the recently released HP devices and future HP devices. This means that HP Web Jetadmin does not have to be upgraded to a newer version to display devices that can be displayed by using any of the UPI classes.

A UPI represents specific products by device class and contains a superset of features and capabilities. The superset of features and capabilities might or might not apply to all of the products that the UPI supports.

Be aware of the following changes that are specific to the UPIs:

- Products are represented by a device class in the UPI. Therefore, the thumbnail image on the Status tab might not reflect the actual image of the device.

  **NOTE:** Feature Packs contain device-specific images for the devices that the UPI supports. The device class UPI image is displayed only when the device-specific image is not available.

- The device capabilities listed on the Capabilities tab for a specific device that a UPI supports might not reflect all of the features that are available for that device.

- Batch mode configuration via the Create Device Configuration Template wizard displays a superset of the configuration features that might or might not apply to a specific device that a UPI supports. For example, when configuring monochrome devices, users might also see the color features that are available for any color devices that the UPI also supports.

The UPIs are found in the Create Device Configuration Template wizard. The HP products that the UPIs support are not listed individually in the wizard. For more information about which HP products are included in each UPI, see the tables in the following sections.

**Enterprise Class UPIs**

**Table 1-1 HP Enterprise MFP UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR4)**

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
<th>Network Cards (Supported in HP Web Jetadmin)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet Enterprise MFP Flow M806†</td>
<td>HP Web Jetadmin 10.3 SR4 (October 2013)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP Color LaserJet Enterprise Flow MFP M680z</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP OfficeJet Enterprise Color MFP X585dn/ X585f</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP Color LaserJet Enterprise MFP M680Dn/ M680f</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP OfficeJet Enterprise Color Flow MFP X585z</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP LaserJet Enterprise MFP M630dn/ M630h/M630f/M630z</td>
<td>HP Web Jetadmin 10.3 SRB (January 2015)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP Color LaserJet Enterprise MFP M577dn/ M577f/M577z/ M577c</td>
<td>HP Web Jetadmin 10.4 (October 2015)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>Devices supported</td>
<td>HP Web Jetadmin release when support was introduced</td>
<td>Network Cards (Supported in HP Web Jetadmin)</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>HP LaserJet MFP M527dn/M527f/M527z/M527c</td>
<td>HP Web Jetadmin 10.4 (October 2015)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP PageWide Color MFP S86dn/S8z, HP PageWide Color MFP E865Odn/Z</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed Flow MFP E72S25z/E72S35z/EB2540z/EB2550z/EB2560z</td>
<td>HP Web Jetadmin 10.4 SR2 (April 2017)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP Color LaserJet Enterprise MFP M681/M682</td>
<td>HP Web Jetadmin 10.4 SR2 (April 2017)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP Color LaserJet Managed Flow MFP E77822z/E77825z/E77830z/EB76640z/EB76650z/EB76660z</td>
<td>HP Web Jetadmin 10.4 SR2 (April 2017)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP PageWide Managed Color Flow MFP E776dn/E77650dns/E77650dns/E77660dns</td>
<td>HP Web Jetadmin 10.4 SR3 (November 2017)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP PageWide Managed Color Flow MFP E776z/E776sz/E77650z/E77650sz/E77660z/E77660z</td>
<td>HP Web Jetadmin 10.4 SR3 (November 2017)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP PageWide Managed P752S0dn</td>
<td>HP Web Jetadmin 10.4 SR5 (January 2019)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed Flow MFP E72S25dn/E72S35dn/E82540dn/E82550dn/E82560dn/E82582dn</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP PageWide Color MFP 751,</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Enterprise flow MFP M28z</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP Color LaserJet Flow MFP M7</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP Color LaserJet Flow MFP M776</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
<td>HP Enterprise NIC</td>
</tr>
</tbody>
</table>
Table 1-1  HP Enterprise MFP UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR4) (continued)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
<th>Network Cards (Supported in HP Web Jetadmin)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet Enterprise MFP M528c/M528x/M528dn/M528f</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP Color LaserJet Managed MFP E78228</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E77422</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E78223</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E77428</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E78228</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP Color LaserJet Flow E77830</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E77822</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E77825</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E77830</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E78323</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E78330</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Managed MFP E78330</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP Color LaserJet MFP M578</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet MFP M635</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet M612</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet M555</td>
<td>HP Web Jetadmin 10.4 SRB (July 2020)</td>
<td>HP Enterprise NIC</td>
</tr>
</tbody>
</table>

1 If HP LaserJet Enterprise MFP Flow M830 and HP LaserJet Enterprise M806 devices were installed in HP Web Jetadmin 10.3 SR3, a discovery or a Refresh Selection (Full) must be performed for these devices after upgrading to HP Web Jetadmin 10.3 SR4 to correctly map them to the new UPI.

Table 1-2  HP Enterprise UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR4)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
<th>Network Cards (Supported in HP Web Jetadmin)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Color LaserJet Enterprise M750n/M750dn/M750xh</td>
<td>HP Web Jetadmin 10.3 SR4 (October 2013)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP Color LaserJet Enterprise M855dn/M855xh/M855x+</td>
<td>HP Web Jetadmin 10.3 SR4 (October 2013)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP Color LaserJet Enterprise M651n/M651dn/M651xh</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP OfficeJet Enterprise Color X555dn/X555xh</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
<td>J8028E</td>
</tr>
<tr>
<td>HP LaserJet M506n/M506dn/M506x</td>
<td>HP Web Jetadmin 10.4 (October 2015)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP PageWide Color 556dn/556xh, HP PageWide Color E55650dn</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
<td>HP Enterprise NIC</td>
</tr>
</tbody>
</table>
Table 1-2  HP Enterprise UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR4) (continued)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
<th>Network Cards (Supported in HP Web Jetadmin)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet M607/M608/M609</td>
<td>HP Web Jetadmin 10.4 SR2 (April 2017)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP Color LaserJet M652/M653</td>
<td>HP Web Jetadmin 10.4 SR2 (April 2017)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP PageWide Color 755dn</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
<td>HP Enterprise NIC</td>
</tr>
<tr>
<td>HP LaserJet Enterprise M507dn/M507dg/M507n/M507x</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
<td>HP Enterprise NIC</td>
</tr>
</tbody>
</table>

1 If HP LaserJet Enterprise MFP Flow M830 and HP LaserJet Enterprise M806 devices were installed in HP Web Jetadmin 10.3 SR3, a Discovery or a Refresh Selection (Full) must be performed for those devices after upgrading to HP Web Jetadmin 10.3 SR4 to correctly map them to the new UPI.

Table 1-3  HP DesignJet MFP UPI 4 color (this UPI class was first released with HP Web Jetadmin 10.4 SR1)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T830 MFP</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP DesignJet T2600 MFP</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
</tr>
</tbody>
</table>

Table 1-4  HP DesignJet UPI 4 color (this UPI class was first released with HP Web Jetadmin 10.4 SR1)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T730</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP Designjet T2600</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Design Jet T650 24-in</td>
<td>HP Web Jetadmin 10.4 SR8 (July 2020)</td>
</tr>
<tr>
<td>HP Design Jet T650 36-in</td>
<td>HP Web Jetadmin 10.4 SR8 (July 2020)</td>
</tr>
</tbody>
</table>

Table 1-5  HP Pagewide XL/HP DesignJet MFP UPI 6+ colors (this UPI class was first released with HP Web Jetadmin 10.4 SR5)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP PageWide XL 4000 MFP/4000PS MFP/4100 MFP/4100PS MFP/4500 MFP/4500PS MFP/4600 MFP/4600PS MFP/5000 MFP/5000PS MFP/5100 MFP/5100PS MFP</td>
<td>HP Web Jetadmin 10.4 SR5 (January 2019)</td>
</tr>
<tr>
<td>HP DesignJet T2600 MFP/T2600 MFP PostScript /T2600dr MFP/T2600dr PostScript MFP</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
</tr>
<tr>
<td>HP DesignJet XL 3600 MFP/3600 PS MFP</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
</tr>
</tbody>
</table>

Table 1-6  HP PageWide XL/HP DesignJet UPI 6+ colors (this UPI class was first released with HP Web Jetadmin 10.4 SR1)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T1700dr</td>
<td>HP Web Jetadmin 10.4 SR3 (November 2017)</td>
</tr>
</tbody>
</table>

ENWW
Table 1-6  HP PageWide XL/HP DesignJet UPI 6+ colors (this UPI class was first released with HP Web Jetadmin 10.4 SR1) (continued)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP PageWide XL 4000/4000PS/4100PS/4500PS/4600/4600PS/8000/8000PS</td>
<td>HP Web Jetadmin 10.4 SR5 (January 2019)</td>
</tr>
<tr>
<td>HP DesignJet T1600/ T1600 PostScript/ T1600dr/ T1600dr PostScript</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
</tr>
</tbody>
</table>

Distributed Enterprise Class UPIs

Table 1-7  HP LaserJet Pro MFP UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR4)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Color LaserJet Pro MFP M476dw/M476dn/M476dn</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP LaserJet MFP M426dw/M426fdn/M426fdw</td>
<td>HP Web Jetadmin 10.4 (October 2015)</td>
</tr>
<tr>
<td>HP LaserJet Pro MFP M225dn/M225dw</td>
<td>HP Web Jetadmin 10.3 SR8 (February 2015)</td>
</tr>
<tr>
<td>HP LaserJet Pro MFP M225rdn/M225rdw</td>
<td>HP Web Jetadmin 10.3 SR8 (February 2015)</td>
</tr>
<tr>
<td>HP LaserJet Pro MFP M226dn/M226dw</td>
<td>HP Web Jetadmin 10.3 SR8 (February 2015)</td>
</tr>
<tr>
<td>HP Color LaserJet MFP M477dnw/M477dn/M477dw</td>
<td>HP Web Jetadmin 10.4 (October 2015)</td>
</tr>
<tr>
<td>HP LaserJet Pro MFP M227d/M227d</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP Color LaserJet MFP M377dnw/M377dn/M377dw</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP Color LaserJet Pro MFP M274n</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP LaserJet Pro MFP M118dw/M148fdw/M148dw</td>
<td>HP Web Jetadmin 10.4 SR5 (January 2019)</td>
</tr>
<tr>
<td>HP Color LaserJet MFP M283fdw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
</tbody>
</table>

Table 1-8  HP LaserJet Pro UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR4)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet Pro M701a/M701n</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP LaserJet Pro M706n</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP LaserJet Pro M201n/M201dn</td>
<td>HP Web Jetadmin 10.3 SR8 (February 2015)</td>
</tr>
<tr>
<td>HP LaserJet M402n/M402dn/M402dw</td>
<td>HP Web Jetadmin 10.4 (October 2015)</td>
</tr>
<tr>
<td>HP LaserJet Pro M203d/M203dn/M203dw</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP LaserJet Pro M501n/M501dn</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP Color LaserJet M255dw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
</tbody>
</table>
### Table 1-8 HP LaserJet Pro UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR4) (continued)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet M209dw</td>
<td>HP Web Jetadmin 10.4 SR8 (July 2020)</td>
</tr>
<tr>
<td>HP LaserJet MFP M234dw</td>
<td>HP Web Jetadmin 10.4 SR8 (July 2020)</td>
</tr>
</tbody>
</table>

### Table 1-9 HP PageWide Pro/HP OfficeJet Pro MFP UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR6 and modified in HP Web Jetadmin 10.4)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP OfficeJet Pro 8610</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP OfficeJet Pro 8620</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP OfficeJet Pro 8630</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP OfficeJet Pro X476dn/X476dw MFP (firmware later than version 1419BR)</td>
<td>HP Web Jetadmin 10.3 SR7 (July 2014)</td>
</tr>
<tr>
<td>HP OfficeJet Pro X576dw MFP (firmware later than version 1419BR)</td>
<td>HP Web Jetadmin 10.3 SR7 (July 2014)</td>
</tr>
<tr>
<td>HP OfficeJet Pro 8710 AiO</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP OfficeJet Pro 8720 AiO</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP OfficeJet Pro 8730 AiO</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP OfficeJet Pro 8740 AiO</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide 377dw MFP</td>
<td>HP Web Jetadmin 10.3 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide Pro 477dn MFP</td>
<td>HP Web Jetadmin 10.3 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide Pro 477dw MFP</td>
<td>HP Web Jetadmin 10.3 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide Pro 577dw MFP, HP PageWide Managed P57750dw MFP</td>
<td>HP Web Jetadmin 10.3 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide Pro 577z MFP</td>
<td>HP Web Jetadmin 10.3 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP LaserJet Pro MFP M428fdn</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
</tr>
<tr>
<td>HP Color LaserJet Pro MFP M479dw, M479fnw, M479fdn, or M479fdw</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
</tr>
</tbody>
</table>

1) For the HP OfficeJet Pro devices, the new features are available only if firmware later than version 1409BR is installed on the device.

### Table 1-10 HP PageWide Pro/HP OfficeJet Pro UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR6 and modified in HP Web Jetadmin 10.4)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP OfficeJet Pro X451dn/X451dw (firmware later than version 1419BR)</td>
<td>HP Web Jetadmin 10.3 SR7 (July 2014)</td>
</tr>
<tr>
<td>HP OfficeJet Pro 8210 Printer</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide 352dw</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide Pro 452dn</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
</tbody>
</table>
Table 1-10  HP PageWide Pro/ HP OfficeJet Pro UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR6 and modified in HP Web Jetadmin 10.4) (continued)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP PageWide Pro 452dw</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide Pro 552dw, HP PageWide Managed P55250dw MFP</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP PageWide Managed Color P75250dn</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
</tr>
<tr>
<td>HP PageWide Managed Color MFP P77440dn</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
</tr>
<tr>
<td>HP PageWide Managed Color MFP P77940dn, HP PageWide Managed Color MFP P77940dn+, HP PageWide Managed Color MFP P77940dn</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
</tr>
<tr>
<td>HP PageWide Managed Color MFP P77950dn, HP PageWide Managed Color MFP P77950dn+</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
</tr>
<tr>
<td>HP PageWide Managed Color MFP P77960dn, HP PageWide Managed Color MFP P77960dn+</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
</tr>
<tr>
<td>HP Color LaserJet M452dw/M452nw/M452dn</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP LaserJet Pro M404dw/dn/ M454nw/M454dn/M454dw</td>
<td>HP Web Jetadmin 10.4 SR6 (June 2019)</td>
</tr>
</tbody>
</table>

1 For the HP OfficeJet Pro devices, the new features are available only if firmware later than version 1409BR is installed on the device.

Fleet Monitoring Class UPIs

**NOTE:** This UPI is for device monitoring only.

Table 1-11  HP S Series MFP UPI (this UPI class was first released with HP Web Jetadmin 10.3 SR5)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Color MFP S951dn</td>
<td>HP Web Jetadmin 10.3 SR5 (January 2014)</td>
</tr>
<tr>
<td>HP Color MFP S962dn</td>
<td>HP Web Jetadmin 10.3 SR5 (January 2014)</td>
</tr>
<tr>
<td>HP Color MFP S970dn</td>
<td>HP Web Jetadmin 10.3 SR5 (January 2014)</td>
</tr>
<tr>
<td>HP MFP S956dn</td>
<td>HP Web Jetadmin 10.3 SR5 (January 2014)</td>
</tr>
</tbody>
</table>

HP ScanJet UPI

Table 1-12  HP ScanJet UPI (this UPI class was first released with HP Web Jetadmin 10.4 SR3 and HP Web Jetadmin 10.4 SR5)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Digital Sender 8500fn2</td>
<td>HP Web Jetadmin 10.4 SR3 (November 2017)</td>
</tr>
<tr>
<td>HP Digital Sender Flow 8500fn2</td>
<td>HP Web Jetadmin 10.4 SR3 (November 2017)</td>
</tr>
<tr>
<td>HP ScanJet Enterprise 8500fn2</td>
<td>HP Web Jetadmin 10.4 SR3 (November 2017)</td>
</tr>
<tr>
<td>HP ScanJet Flow N9120fn2</td>
<td>HP Web Jetadmin 10.4 SR3 (November 2017)</td>
</tr>
</tbody>
</table>
## Samsung UPIs

### Table 1-13  Samsung UPI (this UPI class was first released with HP Web Jetadmin 10.4 SR3 November 2017)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet MFP M72625dn (only discovery and monitoring supported)</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Reporting and alerting is not available or supported for this device.</td>
<td></td>
</tr>
<tr>
<td>HP LaserJet MFP M72630dn (only discovery and monitoring supported)</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Reporting and alerting is not available or supported for this device.</td>
<td></td>
</tr>
<tr>
<td>HP LaserJet MFP M72640dn (only discovery and monitoring supported)</td>
<td>HP Web Jetadmin 10.4 SR4 (May 2018)</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Reporting and alerting is not available or supported for this device.</td>
<td></td>
</tr>
<tr>
<td>Samsung P7600 Series</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
</tbody>
</table>
### Table 1-13  Samsung UPI (this UPI class was first released with HP Web Jetadmin 10.4 SR3 November 2017) (continued)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samsung MultiXpress SL-K3300NR Laser Multifunction Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung MultiXpress SL-M5370LX Laser Multifunction Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung MultiXpress SL-M5370NX Laser Multifunction Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung MultiXpress SL-X3280NR Color Laser Multifunction Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-C3010ND Color Laser Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-C3010DW Color Laser Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-C3050FR Color Laser Multifunction Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-C3060FW Color Laser Multifunction Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-C4010ND Color Laser Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-C4012ND Color Laser Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-C4062FX Color Laser Multifunction Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-M4530ND Laser Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung ProXpress SL-M4530NX Laser Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung SL-P7400LX</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Samsung SL-P7600LX</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
</tbody>
</table>

### ZTC for Zebra devices UPI

### Table 1-14  ZTC for Zebra devices UPI (this UPI class was first released with HP Web Jetadmin 10.4 SR2)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zebra QLn220/320 ZPL</td>
<td>HP Web Jetadmin 10.4 SR4 with Feature Pack 9 (July 2018)</td>
</tr>
<tr>
<td>Zebra ZQ310/320 ZPL</td>
<td>HP Web Jetadmin 10.4 SR4 with Feature Pack 9 (July 2018)</td>
</tr>
<tr>
<td>Zebra ZQ510 ZPL</td>
<td>HP Web Jetadmin 10.4 SR4 with Feature Pack 9 (July 2018)</td>
</tr>
<tr>
<td>Zebra ZD410/420 ZPL</td>
<td>HP Web Jetadmin 10.4 SR4 with Feature Pack 9 (July 2018)</td>
</tr>
<tr>
<td>Zebra ZD500R-203/300dpi ZPL</td>
<td>HP Web Jetadmin 10.4 SR4 with Feature Pack 9 (July 2018)</td>
</tr>
<tr>
<td>Zebra ZT230-200/300dpi ZPL</td>
<td>HP Web Jetadmin 10.4 SR4 with Feature Pack 9 (July 2018)</td>
</tr>
<tr>
<td>Zebra ZT410R-203 ZPL</td>
<td>HP Web Jetadmin 10.4 SR4 with Feature Pack 9 (July 2018)</td>
</tr>
<tr>
<td>Zebra ZT610R-203/300/600dpi ZPL</td>
<td>HP Web Jetadmin 10.4 SR4 with Feature Pack 9 (July 2018)</td>
</tr>
</tbody>
</table>
NOTE: The following Zebra models such as QLn 420 ZPL, ZQ 520 ZPL, ZD620-203d/300dpi ZPL, ZDS500-200/300dpi ZPL, ZT220 ZPL, ZT410 ZPL, ZT420/420R-203/300dpi ZPL, ZT510-203/300dpi ZPL, ZT610 ZPL, and ZT620/620R-203/300dpi ZPL should function like the supported devices in the above list.

### Other plug-ins

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet 510</td>
<td>HP Web Jetadmin 10.1 SR1 (October 2008)</td>
</tr>
<tr>
<td>HP DesignJet Z3200</td>
<td>HP Web Jetadmin 10.1 SR1 (October 2008)</td>
</tr>
<tr>
<td>HP DesignJet Z3200ps</td>
<td>HP Web Jetadmin 10.1 SR1 (October 2008)</td>
</tr>
<tr>
<td>HP DesignJet T1120/T1120ps</td>
<td>HP Web Jetadmin 10.1 SR2 (February 2009)</td>
</tr>
<tr>
<td>HP DesignJet 4020/4020ps/4520/ 4520ps/4520mfp</td>
<td>HP Web Jetadmin 10.1 SR2 (February 2009)</td>
</tr>
<tr>
<td>HP DesignJet T620, T620ps, T1200, T1200ps</td>
<td>HP Web Jetadmin 10.1 SR3 (July 2009)</td>
</tr>
<tr>
<td>HP DesignJet T2300</td>
<td>HP Web Jetadmin 10.2 SR4 (November 2010)</td>
</tr>
<tr>
<td>HP DesignJet Z6200 60-in Photo Printer</td>
<td>HP Web Jetadmin 10.2 SR4 (November 2010)</td>
</tr>
<tr>
<td>HP DesignJet T1300/T790</td>
<td>HP Web Jetadmin 10.2 SR6 (August 2011)</td>
</tr>
<tr>
<td>HP DesignJet T120</td>
<td>HP Web Jetadmin 10.3 SR3 (May 2013)</td>
</tr>
<tr>
<td>HP DesignJet T520 36in</td>
<td>HP Web Jetadmin 10.3 SR3 (May 2013)</td>
</tr>
<tr>
<td>HP DesignJet T520 24in</td>
<td>HP Web Jetadmin 10.3 SR3 (May 2013)</td>
</tr>
<tr>
<td>HP DesignJet T1500</td>
<td>HP Web Jetadmin 10.3 SR3 (May 2013)</td>
</tr>
<tr>
<td>HP DesignJet Z5400 PostScript</td>
<td>HP Web Jetadmin 10.3 SR4 (October 2013)</td>
</tr>
<tr>
<td>HP DesignJet T7100ps</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP DesignJet T795 44-in ePrinter</td>
<td>HP Web Jetadmin 10.3 SR7 (July 2014)</td>
</tr>
<tr>
<td>HP DesignJet T3500 Production 36-in eMultifunction</td>
<td>HP Web Jetadmin 10.3 SR7 (July 2014)</td>
</tr>
<tr>
<td>HP DesignJet T7200 42-in Production Printer</td>
<td>HP Web Jetadmin 10.3 SR7 (July 2014)</td>
</tr>
<tr>
<td>HP DesignJet T7200 42-in Production Printer with PostScript upgrade</td>
<td>HP Web Jetadmin 10.3 SR7 (July 2014)</td>
</tr>
<tr>
<td>HP DesignJet T2500 36-in eMultifunction Printer</td>
<td>HP Web Jetadmin 10.3 SR4 (October 2014)</td>
</tr>
<tr>
<td>HP DesignJet T2500 PostScript eMultifunction Printer</td>
<td>HP Web Jetadmin 10.3 SR4 (October 2014)</td>
</tr>
<tr>
<td>HP DesignJet Z5400 44-in PostScript ePrinter</td>
<td>HP Web Jetadmin 10.3 SR4 (October 2014)</td>
</tr>
<tr>
<td>HP DesignJet Z6600</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP DesignJet Z6600 60-in Production Printer</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
</tbody>
</table>
### Table 1-15 HP Discrete Plug-in (continued)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet Z6800 60-in Photo Production Printer</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP DesignJet Z6800 60-in Photo Production Printer with Encrypted Hard Disk</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP DesignJet Z6810ps 42–in/60–in</td>
<td>HP Web Jetadmin 10.3 SR6 (May 2014)</td>
</tr>
<tr>
<td>HP LaserJet Pro MFP M435nw</td>
<td>HP Web Jetadmin 10.3 SR4 (October 2014)</td>
</tr>
<tr>
<td>HP ScanJet Enterprise Flow 5000 s2</td>
<td>HP Web Jetadmin 10.4 (October 2015)</td>
</tr>
<tr>
<td>HP DesignJet T930 PostScript 36-in Printer</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP DesignJet T930 Printer</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP DesignJet T1530 36-in Printer</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP DesignJet T1530 PostScript 36-in Printer</td>
<td>HP Web Jetadmin 10.4 SR1 (April 2016)</td>
</tr>
<tr>
<td>HP ScanJet Pro 2000s1/2000s1</td>
<td>HP Web Jetadmin 10.4 SR5 (January 2019)</td>
</tr>
<tr>
<td>HP DesignJet T2530 36-in MFP/T2530 PostScript</td>
<td>HP Web Jetadmin 10.4 (October 2015)</td>
</tr>
</tbody>
</table>

**NOTE:** HP DesignJet devices that do not fall into any of the DesignJet UPIs or a device-specific DesignJet plug-in, might be using HP DesignJet. Devices that are supported with this plug-in before HP Web Jetadmin 10.4 SR7 are not are not listed in the following table.

### Table 1-16 HP DesignJet Plug-in

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T100</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP DesignJet T125</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP DesignJet T125 24-in Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP DesignJet T125 36-in Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP DesignJet T130</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP DesignJet T525 24-in Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP DesignJet T525 36-in Printer</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
</tbody>
</table>

### Table 1-17 HP LaserJet Plus UPI (this UPI class was first released with HP Web Jetadmin 10.4 SR7)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Laser Color 150</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Color Laser 150nw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Color Laser MFP 178</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Color Laser MFP 178nw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Color Laser MFP 178nwg</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Color Laser MFP 179</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>Devices supported</td>
<td>HP Web Jetadmin release when support was introduced</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>HP Color Laser MFP 179fnw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Color Laser MFP 179fwg</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser 107W</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser 108w</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 133pn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 135w</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 135wg</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 136w</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 136nw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 137fnw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 137fwg</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 138fnw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 138pn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M437n</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M437dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M437nda</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M438n</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M438dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M438dna</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M439n</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M439dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M439nda</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M440n</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M440dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M440dna</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M442dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M443nda</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M42523n</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M42523dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M42525n</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M42525dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M42623n</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
</tbody>
</table>
### Table 1-17  HP LaserJet Plus UPI (this UPI class was first released with HP Web Jetadmin 10.4 SR7) (continued)

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet MFP M42623dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M42625n</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M42625dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP LaserJet MFP M72630dn</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Laser MFP 432</td>
<td>HP Web Jetadmin 10.4 SR8 (July 2020)</td>
</tr>
<tr>
<td>HP Laser 408</td>
<td>HP Web Jetadmin 10.4 SR8 (July 2020)</td>
</tr>
</tbody>
</table>

**NOTE:** HP mono and color LaserJet devices that do not fall into a UPI use either the HP Color LaserJet plug-in or HP LaserJet plug-in. The following tables list the devices that are supported with those plug-ins since the HP Web Jetadmin 10.4 SR7 release. Older devices are not listed in these tables, but might be supported with those plug-ins.

### Table 1-18  HP LaserJet Plug-in

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Neverstop Laser 1000w</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Neverstop Laser MFP 1200w</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
</tbody>
</table>

### Table 1-19  HP Color LaserJet Plug-in

<table>
<thead>
<tr>
<th>Devices supported</th>
<th>HP Web Jetadmin release when support was introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Color LaserJet M155nw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
<tr>
<td>HP Color LaserJet MFP M183fw</td>
<td>HP Web Jetadmin 10.4 SR7 (December 2019)</td>
</tr>
</tbody>
</table>
Improvements and fixes in previous Service Releases of HP Web Jetadmin

HP Web Jetadmin 10.4 SR7 (10.4.109068)

The following are the improvements and fixes made in HP Web Jetadmin 10.4 SR7 (10.4.109068):

1. REQ 7194/6919: When the firmware upgrade history and the device configuration history is cleared, entries are not created with 1/1/0001 as the date.

2. REQ 7299: HP Web Jetadmin is no longer vulnerable to the Slowloris DOS Attack.

3. CR 12337: Corrected translation for hardware MAC address in German.

4. CR 12444: All devices that are using the HPWSPro Adapter service were showing device communication error in 10.4SR5 or 10.4SR6 when HP Web Jetadmin was installed on a full German or Spanish OS. HP Web Jetadmin is now able to communicate with those devices.

5. CR 12461: When configuring Secure File Erase Mode on a device which doesn’t support this, HP Web Jetadmin is now showing the configuration result as Not supported instead of Success.

6. CR 12507: Print Management is now showing that this functionality is only available for 32-bits print servers.

7. CR12516: Configuration of legacy LaserJet devices, such as HP LaserJet 4100, no longer ends up in error for some of the settings—such as Browser, Ca Certificates, OXP settings—when no EWS password has been configured on the device.

8. CR 12525: Instant-on forwarding is now working when HP Web Jetadmin is installed on a German OS. The HP Web Jetadmin self-signed certificate is installed correctly on the German OS during HP Web Jetadmin installation.


10. CR 12530: HP Web Jetadmin client no longer crashes after loading.

11. CR 12545: HP Web Jetadmin is now correctly showing the 10-digit serial number in the Korean version of Microsoft Windows instead of an incomplete 9-digit serial number.

12. CR 12550: On some upgrades to 10.4SR6, the HP LaserJet M404 device was displayed with a communication error when the LEDM (HPWS Proxy patch for 10.4SR5) patch was installed. The install shield is now informing the user that this patch should be uninstalled before upgrading to SR7.

13. CR 12569: TLS is now working on WS Proxy Agent 8020 port. HPWS proxy is uninstalling the self-signed certificate correctly during an uninstall/upgrade.

14. CR 12582: The SNMP Community Name now has a 255 character limit (previously 20 characters).

15. CR 12583: When creating a Quick Set (Network Folder) on a Future Smart 3 HP Web Jetadmin, the Quick Set was created, but HP Web Jetadmin was showing an error message (invalid data) instead of success. This has now been fixed.

16. CR 12585: HP Web Jetadmin database size was increasing rapidly in SR6 as duplicate entries were getting created during IP discovery. This is now fixed.

17. CR 12679: HP Web Jetadmin can now handle MAC address in uppercase and lowercase and run device utilization reporting successfully. Previously, HP Web Jetadmin could not collect the pagecounts and “Device
Change Error” was displayed for devices that show their MAC address in lowercase. Examples: HP LaserJet M475, HP LaserJet 300 color MFP M375nw, HP LaserJet CP1525nw.

18. CR 12680: When the device has been upgraded to the latest qualified firmware, Printer Firmware Severity shows the correct status, Up-to-date, instead of Updates available.

19. CR 12686: The HP JetAdvantage Link name has been changed to HP Workpath in the Security tab.

20. CR 12687: When applying a configuration template with LDAP and Microsoft Windows user settings for authentications, the settings are configured correctly on the device.

21. CR 12605: When subscribing to general alerts, only Waste Collector alerts were displayed. Now, Toner Collection Unit (TCU) and Fluid Container alerts are displayed.

22. CR 12639/12640/12641: When Misfeed Detection and Automatic tone are enabled in a Quick Set template, and the template is applied to a non-Flow model, the Quick Set was created on the device, but HP Web Jetadmin displayed an error message.

Several improvements have been made to this issue:

– The error message is no longer occurring.
– The HP Web Jetadmin UI is displaying that these configuration options are only for Flow models.
– In single device mode, these configuration items are greyed out.

23. CR 12704: The control panel display text can now be changed, even if the text box contains more than 16 characters.

HP Web Jetadmin 10.4 SR6 (10.4.106526)

HP Web Jetadmin 10.4 SR6 (10.4.106526) includes the following improvements and fixes:

● REQ 7225/CR12158/CR2501: The column Wireless Card is now displayed correctly for FutureSmart devices if an internal wireless card is present. This requires a rediscovery or full refresh.

● CR 12319: HP Web Jetadmin client no longer crashes when a report is sent to an email address that has more than 50 characters.

● CR 12324: The logo listed in the email that is generated when using the supplies alert has been updated.

● CR 12328: HP Web Jetadmin is no longer losing the WINS/DNS values in templates after restarting the HP Web Jetadmin service or server.

● CR 12343: HP Web Jetadmin is no longer using the same connection status for one device with an internal NIC and NW3000 wireless USB connection.

● CR 12363: For several FutureSmart devices, such as the M575 and A3 devices, the alert configuration option Replace Waste Collector has been added.

● CR 12460/12415: The configuration option Access Control for Device functions - FutureSmart 4 is no longer missing for the HP LaserJet 500 Color MFP M575/M525.

● CR 12349: Uploading certificates with the option Upload CA certificate or Upload ID certificate on FutureSmart 4 devices with non-unified certificate storage is now working.

● CR 12366: HP Web Jetadmin now accepts a semicolon as a valid character for the SNMPv3 password.

● CR 12371: XTP ticket with firmware reset for FutureSmart devices is now functioning correctly.
- CR 12380: HP Web Jetadmin is no longer crashing when instant on is enabled before the start of the upgrade.
- CR 12381: HP Web Jetadmin is now showing `<Not supported>` in the column for PJL Passwords for Scanjet devices instead of showing `enabled`.
- CR 12399: HP Web Jetadmin no longer requires a password for EAP configuration with HP LASERJET PRO NIC.
- CR 12405: HP Web Jetadmin is no longer showing a false error messages while configuring SNMPv3 with SNMP Credentials – FutureSmart 3 and Non-FutureSmart devices or with SNMP Credentials - FutureSmart 4.5.
- CR 12420/REQ 7334: HP Web Jetadmin now provides a configuration item to enable/disable wireless status for the M402 device (HP LaserJet Pro UPI).
- CR 12440: When Chinese characters are used for the subscription name, HP Web Jetadmin is now showing the actual Chinese characters for the subscription name instead of question marks.
- CR 12458: Additional debug statements have been added to HP Web Jetadmin for the Instant-On listener.
- CR 12362: When HP Web Jetadmin does not have the current EWS password while unsubscribing from a webservice alert, HP Web Jetadmin is now posting an error message instead of only removing the subscription from the HP Web Jetadmin UI without removing the subscription from the device.
- CR 12455: HP Web Jetadmin now allows an underscore for the systemname (hostname).
- CR 12344: It is now possible to change the Macro ID, when starting the HP Web Jetadmin client in the German language.
- CR 12340/CR12430: After configuring SNMPv1/v2 to read-write with a set community name (with SNMPv3 disabled), HP Web Jetadmin is no longer prompting for the set community name while configuring additional settings with SNMP.
- CR 12487: The HP JetDirect models C5F94A and C5J91A are now available in the filter options for JetDirect Model.

**HP Web Jetadmin 10.4 SR5 (10.4.105723)**

HP Web Jetadmin 10.4 SR5 (10.4.105723) includes the following improvements and fixes:

1. CR 11849: Added functionality to set HTTP Idle Timeout to 0 (disable).
2. CR 12182: Renamed Sleep Timer Settings to Sleep Setting.
5. CR 11974: A global template of the home screen application is the same as a configuration of the home screen application on HP Web Jetadmin.
6. CR 11975: A global template of the home screen application is the same as a configuration of the home screen application on HP Web Jetadmin and no errors are displayed in global templates.
7. CR 11966: All home screen items are not removed after sending HP Web Jetadmin template to a FutureSmart 4.5/4.6.01 device.
8. CR 11862: Password field should be configurable with user variable data.
9. CR 11868: Added column and filter option for configuration item Windows Users and Groups.

10. CR 11714: Added a warning to the HP Web Jetadmin installer: After upgrading HP Web Jetadmin the HP Web Jetadmin service will always be running under the network service account.

11. CR 11935: HP PageWide XL devices now display a wider box for the supply levels.


13. CR 12235: Added information in the HP Web Jetadmin UI about enabling HP JetDirect XML services before changing the IPsec/Firewall settings.

14. CR 12001: While multiple IP Address are selected, the new/import/export button is disabled. When selecting a single IP address, the option is available.

15. CR 12200: The verify access button in Quick Set (Scan to Folder) has been removed in template mode.


17. CR 11901: Corrected translation for cleaner in German.

18. CR 11903: Filters no longer have a character limit of 32,768.

19. CR 11904: LDAP Server Name no longer fails to set claiming Invalid Data while the LDAP settings are valid.

20. CR 11906: The template name can now be 100 characters (was 48 characters).

21. CR 11908: The template is no longer prompting for SNMP v1 Get Community Name while the device is set as SNMPv3 enabled and SNMP V1/V2 disabled.

22. CR 11932 (HP PageWide XL): HP Web Jetadmin no longer rounds the remaining cartridge value to a higher value.

23. CR 11939 (HP PageWide XL): HP Web Jetadmin no longer shows cartridge unknown on the status tab when the device is in powersave.

24. CR 11940 (HP PageWide XL): HP Web Jetadmin no longer shows the cartridge level as unknown when the cartridge is missing.

25. CR 11968: All quickset icons are no longer removed from home screen after applying a template that has QuickSet options set as keep as is.

26. CR 11969: Keep as is for access control settings for the device settings is no longer changed into disabled after saving the template.

27. CR 11973: The configuration option HOME SCREEN LANGUAGE SELECTION is available for HP Enterprise UPI.

28. CR 12000: When using a ticket with filtering for HP PageWide Pro, the value in the user defined field changes now automatically.

29. CR 12026: After mapping XML tickets to user defined fields and refreshing the Users Settings category the value for the XML ticket is now displayed.

30. CR 12035: When the encryption on the device is set to high, a device communication error no longer occurs with PageWide devices using limo firmware.

31. CR 12041: When a QuickSet is edited in an existing template, the checkbox for QuickSets configuration is no longer removed.
32. CR 12050: The device communication error with HP PageWide Pro devices no longer occurs.

33. CR 12098: QuickSet X and Y dimensions no longer default to 7 and 8 and misfeed detection is not checked by default. Path credentials are now verified in template mode. HP Web Jetadmin now warns of missing path credentials.

34. CR 12138: Device communication error no longer occurs when SNMPv1 is set to default settings and SNMPv3 is disabled on FS3 device or devices with limo firmware.

35. CR 12166: When using the context sensitive help for Link Settings, HP Web Jetadmin displays the Link Settings help file.

36. CR 12197: The option Upload CA certificate is no longer linked with J7982E.

37. CR 12006: HP Web Jetadmin can now configure SNMP on FutureSmart devices when the NW3000 NFC WiFi accessory is installed and WiFi direct is enabled.

38. CR 12184: When exporting a device list from HP Web Jetadmin, the default file name no longer has a space in front of it. The space prevented the file from being saved to Microsoft OneDrive.

39. CR 11955: Improved refresh of the device category for OZ devices, such as HP LaserJet M3035.

**HP Web Jetadmin 10.4 SR4 (10.4.104106)**

HP Web Jetadmin 10.4 SR4 (10.4.104106) includes the following improvements and fixes:

1. CR 11854: Performance issues when expanding all the configuration categories. When communicating over SNMPv3 and SNMPv2 is disabled, the additional wait time is longer.

   **Workaround:** Instead of expanding a full category to read the device settings, add the settings you want to read to the My Settings category. Refresh the My Settings category. The performance will be improved with the Feature Pack 9 release.

2. CR 11493: HP Web Jetadmin configures the default login for the application group EWS on the device when the same is selected in HP Web Jetadmin.

3. CR 11524: The Upload JetDirect certificate was renamed Upload Certificate.


5. CR 11548: SNMPv3 passphrases are accepting special characters such as ! (exclamation mark).

6. CR 11557: The **Verify** button is selectable when creating a Quick Set for the Save To Network folder in template mode.

7. CR 11566: When sending a template with SNMP settings to a device that has SNMPv1/v2 disabled and SNMPv3 enabled, the SNMPv1 credential screen does not appear.

8. CR 11568: When HP Web Jetadmin has the SNMPv3 credentials for the device, HP Web Jetadmin is using SNMPv3 for SNMP get/set operations.

9. CR 11572: In the PJL password column, HP Web Jetadmin shows the correct status for the PJL password.

10. CR 11588: The **Get Firmware Images** window can be resized.

11. CR 11589: When creating a template, the model name is not highlighted in blue and the double arrow button is not active without clicking on a model name first. After clicking on a model name, the selected model is highlighted in blue and the arrow buttons are selectable.
CR 11614: When the setting **Allow fw upgrades send as print jobs (port 9100)** is enabled, HP Web Jetadmin can upgrade firmware on FutureSmart devices.

CR 11618: The configuration option **Printer Firmware Update** under the security category has been renamed into **Printer Firmware Update (send as printjob)**.

CR 11619: **Control Panel Shortcuts** under the security category was renamed **Homescreen Customization (PageWide)** and is available under the device category.

CR 11628: The configuration option **Enable Host USB plug and play** was renamed **Host USB plug and play**.

CR 11629: The configuration option **Enable P JL Device Access** was renamed **P JL Device Access Commands**.

CR 11630: The **Clear Wallpaper** option for **Homescreen Wallpaper Customization** is now displayed with a checkbox in the template instead of a button.

CR 11631: After creating a template with an image for **Homescreen Wallpaper Customization**, the template is listed under the templates with a value of ***** for the **Homescreen Wallpaper Customization** setting.

CR 11635: The **LDAP Sign-In feature field** **Bind Prefix**, no longer has to be filled in when .NET 3.5.1 is installed. If you are using Microsoft Windows 8.1, .NET 3.5.1 must be installed before installing HP Web Jetadmin.

CR 11641: Possible to configure SNMPv3 devices with SHA1/AES-128 using the option **SNMP-credentials-FutureSmart 4.5**.

CR 11642: Templates with the FutureSmart 4.5 and SHA1/AES-128 SNMP settings do not lose the template settings after applying the template.

CR 11649: The configuration options **Local Administrator Password** and **Remote Configuration Password** have been added for the J8028e.

CR 11651: The SNMPv1 credentials screen is no longer popping up when sending configuration templates to a device with SNMPv1 set to read-only.

CR 11655: The configuration options **Enable Save to Network Folder/Sharepoint/USB/Send to Email** was renamed **Save to Network Folder/Sharepoint/USB/Send to Email**.

CR 11664: When the default **Get Community Name of public** is disabled, the EWS prompt no longer occurs when HP Web Jetadmin is retrieving the values for **Homescreen Wallpaper Customization** or **Homescreen Applications - FutureSmart 4**.

CR 11666: HP Web Jetadmin does not display the error message: **Unexpected error. Make sure all settings have valid values** while editing an existing template that has the configuration options **P JL File System Access** and **PS File System Access** enabled.

CR 11667: HP Web Jetadmin can now discover an SNMPv3 configured printer that has SNMPv1 set to read-only and the SNMP get community name public disabled.

CR 11678: When you search in the HP Web Jetadmin help with the keyword **backup**, the help link for the configuration option **Backup** appears.

CR 11686: An information note has been added to the configuration option **Upload CA certificate** under the network category, which explains when the configuration option **CA Certificates**, under the device category, must be selected.

CR 11691: A combination of variable and static data containing a slash for the UNC folder Path in the configuration option **Backup** is working.
31. CR 11693: The **New** button for **Specified Addresses** discovery (available under Tools>Options>Shared>Discovery>Methods) was renamed **New>Import>Export**.

32. CR 11704: A3 paper size is available in Quick Sets for FutureSmart (MFP) UPI. The Black TIFF Compression and Color TIFF Compression options are not greyed out when creating a Quick Set for FutureSmart devices.

33. CR 11715: When refreshing the configuration option **Backup** under the device category, a FutureSmart printer does not display **Unable to encrypt or decrypt the backup file**.

34. CR 11743: When SNMPv1 is set to read-only and SNMPv3 is disabled on an HP PageWide Pro device, HP Web Jetadmin is no longer prompting for the SNMPv3 password when expanding device category.

35. CR 11745: You can use 3 different states for the Show/Hide column in a template with **Homesscreen Applications FutureSmart 4**. You can also select **keep configuration as** on a device or override the device view by viewing/adding or hiding the application.

36. CR 11754: You can delete all custom address books without having to select something else to be deleted.

37. CR 11761: When modifying the SNMPv3 setting with the configuration option **SNMP-credentials FutureSmart 4.5**, HP Web Jetadmin does not request the EWS credentials.

38. CR 11781: When creating a filter for Jetdirect models, the J8032E Jetdirect model appears.

39. CR 11263: Text font and text color values are hidden in Microsoft Windows 2016 server for paper handling finisher devices.

40. CR 11554/11817: HP Web Jetadmin no longer prompts for SNMPv1 credentials when SNMPv1/v2 is disabled and while HP Web Jetadmin has the SNMPv3 credentials.

**HP Web Jetadmin 10.4 SR3 (10.4.103287)**

HP Web Jetadmin 10.4 SR3 (10.4.103287) includes the following fixes:

1. **REQ 6975**: Renamed Job Hold Timeout to Stored Jobs (Delete Temporary Jobs After) with a note in the UI showing the old name.
   
   Renamed Job Retention to Stored Jobs (Allow on this device) with a note in the UI showing the old name.
   
   Renamed Stored Job Sort order to Stored Jobs (Sort/List Order).
   
   Renamed Job storage limit to Stored Jobs (Temporary Storage Limit).

2. CR 11523: Complex column **Device Certificates** should be called **CA Certificates**. Now CA Certificates and ID certificate can be easily displayed in HP Web Jetadmin.

3. CR 11417: Resolved some inconsistency in naming SNMPv3 passphrase and SNMPv3v3 password was used in global credential store and in the device discovery wizard in HP Web Jetadmin. Now everywhere in HP Web Jetadmin the term passphrase is used.

4. CR 11387: HP Web Jetadmin is now showing the Importable Device Settings in alphabetic order instead of random order, while using the option Configuration, Import from file.

5. CR 11239: Devices are no longer showing "Not supported" after synchronization with another HP Web Jetadmin server.

6. CR 11251: Option Import/Export address book is now also available for M60x devices.

7. CR 11252: It’s now possible to change the database memory size (RAM) to more than 1 GB.
8. CR 11253: Default SQL server memory size has been increased to 2 GB for new HP Web Jetadmin installations.

9. CR 11362: HP Web Jetadmin is no longer requiring to fill in user credentials when using MFP user credentials to connect after sign-in at the control panel is selected in the LDAP settings under the Security category.

10. CR 11297: The Use Another Tray option now works with HP LaserJet 4350.


12. CR 11303: Configuration option Quick Sets remains available in the device category even after a device refresh or full refresh.

   The options File name prefix and File name suffix that are part of the Email File Settings option in the Digital Sending category will be set to None in HP Web Jetadmin, when no setting is present while editing a template (previously the selection remained blank in HP Web Jetadmin).

13. CR 11308: Supply level value (such as approximate percentage remaining) is now displayed correctly in the Supplies tab (and in the corresponding HP Web Jetadmin column) for legacy LaserJet devices. Supply alerts are also working again.

14. CR 11347: SLP Discovery can now be disabled without getting an "unexpected error" message.

15. CR 11363: When creating an export schedule for a device group, you can now select a group that contains zero devices at the moment of creating the scheduled export.

16. CR 11388: It’s now possible to create user defined fields with an underscore in the name without having to use copy and paste. When importing a csv file with configuration settings, HP Web Jetadmin will now match the hostname from the csv file with the hostname of the device in HP Web Jetadmin in a case insensitive way.

17. CR 11406: Network connected M400 devices are no longer intermittently cycling between ready and communication error states.

18. CR 11436: HP Web Jetadmin is no longer hanging with the message “retrieving information” after a refresh when a configuration item that is not supported by the device has been added to My Settings.

19. CR 11455: HP Web Jetadmin is no longer randomly missing configuration options under Email File Settings for HP PageWide Pro 477-577 series. The Default resolution under Email File Settings is no longer greyed out for HP Enterprise MFP UPI.

20. CR 11430: It’s now possible to delete bdl files from the solution repository. The delete button is no longer greyed out.

21. CR 11493: When using the Access Control for Device Functions configuration option, HP Web Jetadmin now configures the sign-in method for the selected application groups.

22. CR 1149: Device picture for HP Color LaserJet Flow EB7630 has been added to Feature Pack 6.

HP Web Jetadmin 10.4 SR2 (10.4.101995)

The following are the improvements and fixes made in HP Web Jetadmin 10.4 SR2 (10.4.101995):
1. CR 11316: The HPWS Pro Adapter service no longer stops after discovering one of the following devices: HP PageWide XL 5000PS MFP, HP PageWide XL 8000PS, HP DesignJet T830 MFP, HP DesignJet T730.

2. CR 11319: The HP PageWide XL 5000PS MFP, HP PageWide XL 8000PS, HP DesignJet T830 MFP and HP DesignJet T730 now display the supplies levels. This was an issue in 10.4 SR2 versions 10.4.101899, and 10.4.101715.

HP Web Jetadmin 10.4 SR2 (10.4.101995) also includes the improvements and fixes from the previous 10.4 SR2 release (10.4.101899):

1. CR 11303: After refreshing a device, the Quick Sets configuration option remains visible under the config tab under the device category for FutureSmart 3 devices.

2. CR 11308: HP Web Jetadmin correctly displays the actual supplies information for legacy LaserJet devices (OZ devices) and devices supported with the HP S Series MFP UPI. Supplies alerts for legacy LaserJet devices are now working correctly.

HP Web Jetadmin 10.4 SR2 (10.4.101995, and 10.4.101899) also includes the improvements and fixes from the initial 10.4 SR2 release (10.4.101715):

1. CR 11031: HP Web Jetadmin can now be configured to use only qualified images for firmware upgrades. After setting ConsiderQualifiedFirmwareAsLatest to True and restarting the HP Web Jetadmin service, only qualified images will be considered for a firmware upgrade. For more information, see the HP Web Jetadmin help, or the Upgrading Firmware Using HP Web Jetadmin whitepaper.

2. REQ 5985: Move Up and Move Down buttons have been added to change quick sort ordering.

3. REQ 6316: When creating templates with Quick Sets, added the option to keep a current Quick Set setting untouched.

4. REQ 10867: The option “Retrieve the devices user’s name using this attribute” under Windows Sign in and Setup can now be used for non-FutureSmart devices and no longer shows “Not specified”.

5. CR 10875: “Printer Firmware – Available” has been renamed to “Printer Firmware - Available in HP Web Jetadmin Repository.”

6. CR 10931: HP Web Jetadmin uses the same bold/regular font selection as the EWS does for the Access Control for Device Functions in the Security category.

7. CR 10930: HP Web Jetadmin uses the same names as the EWS for the complex column in ePrint Settings.

8. CR 10947: HP Web Jetadmin shows “AirPrintScan (eSCL/WebScan)” instead of “AirPrintScan” (changed with Feature Pack 4).

9. CR 10955: Renamed Tray 1 Mode to “Tray 1 Mode/Manual Feed” and renamed option “Cassette” into “Cassette (Manual Feed disabled)”.

10. CR 10894: HP Web Jetadmin service is now configured with Automatic (Delayed Start). After installing a Feature Pack, clicking Apply, and then restarting the HP Web Jetadmin server, the service pack status changes the Feature Pack status from Happening to Applied.

11. CR 10932: The window size for Control Panel Application list in Access control for device applications has been increased to simplify UI navigation.

12. CR 11004: Cartridge Threshold settings are referring to estimated supplies level for all devices, instead of toner devices only.

13. CR 11056: Added reference to FTP to configuration options when creating Quick Sets.
14. CR: 11033: Report size can be increased, which makes it much easier to select the right reporting columns.

15. CR 11072: Home Screen Applications had been renamed to Home Screen Applications - FutureSmart 3 to emphasize that it will only apply to FutureSmart 3 devices.

**NOTE:** FutureSmart 3 templates remain FutureSmart 3 templates during the upgrade to 10.4 SR2.

16. CR 11083: Sorted drop down list for Importable Device Settings.

17. CR 11085: Changed “Air Print” to “AirPrint”.

18. CR 11134/10833: mDNSService name changed to Bonjour Service Name (mDNSService Name) to match EWS terminology.

19. REQ 6787: Guard Interval configuration options removed from HP Web Jetadmin, as the device is not supporting the different settings.

20. CR 10639: For devices such as m880, X585, M630, and M775, without changing snmptimeout to 3000 ms HP Web Jetadmin no longer prompts for snmp set community name when changing the tray1 size and/or type.

21. CR 10837: It’s no longer possible to create the discovery specified address entries that have the same names and different capitalization. In previous versions, HP Web Jetadmin created both entries (even when an error message was displayed) and hid one entry that caused UI movements. HP Web Jetadmin is now preventing duplicate names with different capitalization.

22. CR 10843: After configuring an HP Web Jetadmin template on a device with two home screen Quick Sets (one for save to network folder and one for save to email), the cc and bcc address won’t be pre-filled with the name of a new address book entry that is created from the printer’s control panel.

23. CR 10844: In single device mode, HP Web Jetadmin shows that a user password is set for the outgoing email server.

24. CR 10876: It’s possible to upload CA certificates and/or Jetdirect certificates when the HP Enterprise NIC is selected for devices like M605, and M527.

25. CR 10878: The Tray 1 mode setting cassette no longer changes to First after restarting the HP Web Jetadmin service.

26. CR 10881/REQ 6716: Quick Sets saved as home screen applications are ordered consistently across devices using the same templates.

27. CR 10882: Deleting templates is now faster when there is a high number of groups. HP Web Jetadmin checks and removes the template from group policies for several groups instead of group by group.


29. CR 10906: Print device list did not work in 10.4 SR1. This is working again.

30. CR 10945: Cross frame scripting and clickjacking has been addressed in 10.4 SR2.

31. CR 10956: It’s possible to set the EWS password with 16 characters from HP Web Jetadmin on devices such as the HP OfficeJet Pro X764dn.


33. CR 10979: HP Web Jetadmin configure software for OfficeJet Pro devices with the UNC for a network location starting with a digit (for example, \2asdf\c$).
34. CR 10988: Keyboard mappings can be exported.

35. CR 11000: When configuring the home screen language setting or inactivity timeout on FutureSmart 4 devices, HP Web Jetadmin no longer pushes all home screen applications to the first page.

36. CR 11009: Color crop option is no longer greyed out in HP Web Jetadmin when creating a Quick Set with Save to Network Folder, Save to USB or Save to Email.

37. CR 11023: Device disconnected alert messages contain device information instead of a null value when sending to a SNMP trap destination.

38. CR 11025: When creating device disconnected alerts to different destinations, HP Web Jetadmin sends the alerts to both destinations.

39. CR 11034: Email addresses ending with .intern are accepted as valid email addresses for fax send configuration.


41. CR 11057: HP Web Jetadmin is no longer displaying an “Error reading device settings” message when trying to display the device category details for HP OfficeJet Pro 451 and 551 devices that use firmware that is not supporting the TimeZone/Daylight Savings option.

42. CR 11058: Default media size and default media type can be configured with HP Web Jetadmin on HP OfficeJet Pro devices with older firmware without generating a data error.

43. CR 11059: Status screen no longer shows <not supported> below Ready in HP Web Jetadmin for HP OfficeJet Pro 451/551 devices.

44. CR 11065: HP Web Jetadmin filters by email attachment size.

45. CR 11084: HP Web Jetadmin displays link speed correctly for devices such as HP LaserJet M577, and HP Color LaserJet M553.

46. REQ 6681: Details of complex columns (columns with a magnifier) can be displayed at all levels.

47. REQ 6728: HP Web Jetadmin no longer throws invalid data errors while changing an existing folder that was created through the EWS with a prefix in Device Date (DDMMYY) format.

48. CR 11138: HP Web Jetadmin exports the details of the Trays and Outgoing server (like email server address) columns (complex columns) instead of just exporting the number of entries (like 4 email servers).

49. CR 11145: Automatic Tone option is no longer grayed out while creating a Quick Set for the scan to email function.

50. CR 11187: Snmpv1 credentials no longer pop when trying to configure snmpsettings on a device while snmpv1/v2 is set to read-only.

51. CR 11190: When configuring HP Web Jetadmin, Service Access Code is removed to hide Printable Reports and pages on info tab for users.

52. CR 11209: HP Web Jetadmin no longer shows solutions on a device after the solution has been removed from the device with HP Web Jetadmin.

53. CR 11225: SHA1/AES-128 can be configured for snmpv3 for J8022E (used by devices such as HP DesignJet T930 and T2530).
The following are the improvements and fixes made in HP Web Jetadmin 10.4 (10.4.99821):

1. CR 10639: HP Web Jetadmin now uses the User Name (%SECURITY_USERNAME%) variable instead of the User Name (%SECURITY_USER_NAME%) variable for the file name prefix and suffix on the Email File Settings and Network Folder File Settings configuration options. These configuration options are available in the Digital Sending category on the Config tab.


For HP legacy devices, the problem with importing an address book that contains Japanese characters has been fixed in firmware version 48.390.4.

3. CR 10692: The 802.11 b/g/n configuration option has been renamed to Wireless Station (802.11). This configuration option is available in the Wireless category on the Config tab.

4. CR 10693: The Enable Wireless Station configuration option has been renamed to Enable Wireless Station (802.11). This configuration option is available in the Wireless category on the Config tab.

5. CR 10701: The Retrieve the device user's name using this attribute check box has been added to the Windows Sign In Setup configuration option. This configuration option is available in the Security category on the Config tab.

6. CR 10719: The mDNS Config check box on the Network Enable Features configuration option has been renamed to Bonjour (mDNS Config). This configuration option is available in the Network category on the Config tab.

7. CR 10720: The Enable Secure PJL configuration option has been renamed to Enable PJL Device Access Commands. This configuration option is available in the Security category on the Config tab.

8. CR 10723: When creating a discovery template that uses the Specified Addresses discovery method, HP Web Jetadmin would freeze if two names for the specified IP addresses were identical except that one name contained a space at the end. HP Web Jetadmin no longer stores two names with IP addresses where the only difference is that one name has a space at the end.

9. CR 10726: When applying a device configuration template to devices when the HP Embedded Web Server (EWS) credentials are invalid, HP Web Jetadmin now provides a Stop the task option in the Cancel Credentials window.

10. CR 10727: When only one device is listed on the Needed Credentials window, if users enter the HP Embedded Web Server (EWS) credentials, and then click the Finish button without clicking the Set button first, HP Web Jetadmin now uses the credentials entered instead of displaying an error message.

11. CR 10730: When editing an SMTP configuration template, HP Web Jetadmin did not reuse the user password for the outgoing email server. When changing the Server name or address option on the Outgoing Servers configuration option for an existing device configuration template, HP Web Jetadmin will no longer ask the user to re-enter the user password because it is already in the SMTP configuration template.

12. CR 10747: The scripts to back up and restore HP Web Jetadmin have been modified to work correctly when HP Web Jetadmin and Microsoft SQL Server are installed on a drive other than the default system drive (C:).

13. CR 10753: When importing a user-defined device configuration setting from a comma-separated values (CSV) file into HP Web Jetadmin, the <ignore this column during configuration> option now works correctly.
14. CR 10765: The name of the None check box in the Duplex Binding configuration option has been changed to None (1-sided). This configuration option is available in the Device category on the Config tab.

15. CR 10770: HP Web Jetadmin now allows long domain names, such as *.intern, to be specified in the Default from box on the Email Address/Message Settings configuration option. This configuration option is available in the Digital Sending category on the Config tab.

16. CR 10774: HP Web Jetadmin no longer sets a dialing prefix on the devices from the Fax Send Settings configuration option when no dialing prefix is specified in HP Web Jetadmin. This configuration option is available in the Fax category on the Config tab.

17. CR 10786: For the HP LaserJet M3035 MFP, HP LaserJet M4345 MFP, and HP LaserJet M5035 MFP devices, HP Web Jetadmin now correctly displays the values when the Device category is selected on the Config tab.

18. CR 10795: When specifying the filter criteria for an automatic group, the values for the Permission (Access Control for Device Functions) option in the Device Property list have been changed from Yes and No to Yes (Access Granted/Full Access) and No (Required Sign In/Access Denied).

19. CR 10797: When specifying the filter criteria for an automatic group, the Device Applications and All Device Applications options in the Device Property list have been renamed to Control Panel Applications and All Control Panel Applications to match the names used in the device HP Embedded Web Server.

20. CR 10798: When a complex column is added to a device list, HP Web Jetadmin now shows the data that can be expanded as a hyperlink in blue text.

21. REQ 6626: When importing HP FutureSmart solutions (*.bdl) into the Solutions Repository, customers no longer need to select the All files (.*.*) option. HP Web Jetadmin now also displays the imported *.bdl files in the Solutions Repository.

22. CR 10893: Previously installed licenses were lost when upgrading to HP Web Jetadmin 10.4 SR1 (10.4.99186). This issue has been fixed in the latest build of HP Web Jetadmin 10.4 SR1 (10.4.99821). If you have already upgraded to 10.4.99816, all of the installed licenses must be reinstalled.

23. CR 10803: The NOT statement in queries was sometimes ignored when two filter criteria are combined into one complex filter. This issue has been fixed.

**HP Web Jetadmin 10.4 (10.4.98174)**

The following are the improvements and fixes made in HP Web Jetadmin 10.4 (10.4.98174):

1. CR 10205: If the decimal separator on the operating system is set to a comma (,), HP Web Jetadmin now correctly configures the LDAP settings.

2. CR 10222: For legacy HP LaserJet devices, HP Web Jetadmin now correctly displays Atlantic Standard Time instead of SA Western Standard Time in the Time Zone Name (Time Zone/Daylight Savings) column in device lists when the Time Zone configuration option is set to GMT-04:00 Atlantic Time (Canada).

3. CR 10234: HP Web Jetadmin could not recognize USB-connected HP LaserJet Pro MFP M521 devices through HP SNMP Proxy Agent on Windows 8. This has been fixed in HP SNMP Proxy Agent.

4. CR 10239: The HP Web Jetadmin client can now be started over HTTPS when a remote database is used or when the HP Web Jetadmin service runs as a user account.

5. CR 10250: HP Web Jetadmin now indicates that the FirmwareUpgradeThreadSize setting must be increased if the number of maximum concurrent firmware upgrades is set to 11 or higher.

6. CR 10276: HP Web Jetadmin now indicates that the Estimated Supplies Levels configuration option must be enabled when using 1% increments for the supply level thresholds.
7. CR 10279: HP Web Jetadmin now provides the option of selecting Hebrew as the alternate keyboard layout when running HP Web Jetadmin in Japanese.

8. CR 10285: The HP Web Jetadmin background polling no longer wakes up devices.

9. CR 10287: For the LDAP Settings configuration option, HP Web Jetadmin now disables the Match the Recipient's Name with this attribute, Attribute Name for Recipient's Email Address, and Attribute Name for Recipient's Fax Number settings when the Use Active Directory default or Use Exchange 5.5 Default option is selected from the Source for Attribute Names list.

10. CR 10309: HP Web Jetadmin now indicates that the Import/Export Address Book configuration option can be used to import multiple user accounts on multifunction printers (MFPs).

11. CR 10310: When using the Send to Network Folder option to create a Quick Set, HP Web Jetadmin now suggests the correct custom subfolder name %SECURITY_USER_NAME% instead of %SECURITY_USERNAME%.

12. CR 10319: The number of log files for the HPWSProAdapter services no longer increases rapidly because the default logging is now set to ALL instead of ERROR in the HP.Dss.App.Service.exe.Configuration.config file. This file is available in the following directory:

   \Program Files\Hewlett-Packard\Web Jetadmin 10\HPWSProAdapter\FileSystems\Product\Panther\Configuration

13. CR 10341: HP Web Jetadmin could not be upgraded to version 10.3 SR8 or earlier when the size of the HP Web Jetadmin database was larger than several GB.

   **NOTE:** If you cannot upgrade to HP Web Jetadmin 10.4 or later, you might also be required to increase the upgrade timeout by using the instructions in the following **Solution.**

   **Solution:**

   a. Use Notepad or a similar editor to open the DatabaseSettings.config.xml file. This file is available in the following directory:

      Windows\ServiceProfiles\NetworkService\AppData\Local\Hewlett-Packard\HPWebJetadmin\WjaService\config

   b. Update or add the following section to the DatabaseSettings.config.xml file:

      ```xml
      <property name="DatabaseConnectionFactory.CommandTimeoutInSeconds">
       <value>1500</value>
      </property>
      ```

      Specifying a value of 1500 will resolve most upgrade timeout failures. However, a higher value can be specified if needed.

14. CR 10358: HP Web Jetadmin no longer shows a status of Device Communication Error for devices, such as the HP OfficeJet Pro X476, that use the HPWSProAdapter service on some multi-homed servers.

15. CR 10370: On the Select options page of the Apply Solution Template wizard, all of the solutions are now listed in alphabetical order instead of listed in random order.

17. CR 10409: When configuring the Access Control List configuration option for HP LaserJet 400 M401 devices when SNMPv3 is enabled and SNMPv1 is set to read-only, HP Web Jetadmin no longer displays Not supported on the Results page.

18. CR 10410: HP Web Jetadmin now successfully configures the Access Control List configuration option for HP LaserJet 4250, HP Color LaserJet CP3525, and HP LaserJet P4015 devices when SNMPv3 is enabled and SNMPv1 is set to read-only.

19. CR 10481: After changing the HP Embedded Web Server (EWS) password for an HP LaserJet 400 M401 device, all of the HP FutureSmart devices no longer have a status of Device Communication Error.

20. CR 10548: When receiving alerts, HP Web Jetadmin no longer shows null instead of the actual device data, such as IP Hostname: null.

21. CR 10570: When creating device configuration templates, HP Web Jetadmin now accepts the characters 0 through 9 in the name of the outgoing server.

22. CR 10578: When configuring Windows Users and Groups for HP FutureSmart devices, HP Web Jetadmin now accepts the hyphen (-) and backslash (\) as valid characters, which matches the behavior of the HP Embedded Web Server (EWS).

23. REQ 6584: HP Web Jetadmin now sets the Include thumbnail option for the Fax Receive Settings and Fax Send Settings configuration options on HP FutureSmart devices that have firmware version 3.4 or later.

24. REQ 5887: When applying a device configuration template that has a customized order defined for the Quick Sets to multiple devices, the Quick Sets are now listed in the same order on all of the devices.

25. REQ 6563: HP Web Jetadmin can now delete PIN-protected jobs on HP legacy devices that have firmware version 13.2 or later.

**HP Web Jetadmin 10.3 SR8 (10.3.96073)**

The following are the improvements and fixes made in HP Web Jetadmin 10.3 SR8 (10.3.96073):

1. HP Web Jetadmin was changing the hostname of a device when the device was turned off. This was a problem in environments with DHCP servers, which always registered hostnames even if the IP address was not distributed. In some cases, HP Web Jetadmin was also changing the hostname if two devices swapped their IP addresses after a DHCP renewal.

   **Implemented fix:**

   First check the status of the device. If the device status is **Device Communication Error**, do not update the hostname.

   If the device status is not **Device Communication Error** and the hostname on the device is different from the hostname in HP Web Jetadmin, check the device for the model number, model name, and serial number. Update the hostname only if these three values on the device are the same as the values on HP Web Jetadmin.

2. Scheduled exports of the IP hostname and default From email address are now completing as fast as manual exports.

3. Data collection is now possible when the regional settings are set to Korean.

4. The Company Name column on the Accessory Inventory report now shows the company name that is set on the device by using the Fax Header Settings configuration option.

5. HP Web Jetadmin now exports the IP address of the outgoing email servers for HP FutureSmart devices.
6. When creating an IPsec template on the IPsec/Firewall Policy configuration option, users can now specify a remote IP address.

7. Users can now export the Permission Sets column on device lists, which is available as a subcolumn of Access Control for Device Functions.

8. When the regional settings are set to German, starting the HP Web Jetadmin client and the initial browsing are no longer extremely slow.

9. HP Web Jetadmin now accepts a domain name that has more than 3 characters, such as .corp, for Internet fax providers.

10. Performance improvements have been made when refreshing HP FutureSmart devices that have a status of Device Communication Error.

11. For HP LaserJet Enterprise P3015 devices, the HP XML Services option is now available on the Network Enable Features configuration option. This configuration option is available in the Network category on the Config tab.

12. In the HP Web Jetadmin Firmware Repository, firmware-friendly names for HP FutureSmart devices, such as HP FutureSmart 2 SP2.06, no longer appear as the actual version.

13. When creating a device configuration template for the HP Enterprise MFP UPI, the Save to SharePoint® option is now available on the Access Control for Device Functions configuration option. This configuration option is available in the Security category on the Config tab.

14. The title of the Default Original Density configuration option has been changed to Copy Contrast so that it aligns with the EWS. This configuration option is available in the Copier category on the Config tab.

15. The title of the Notification Condition (Fax Receive Settings) column on device lists has been changed to Condition on which to notify (Fax Receive Settings).

16. HP Web Jetadmin can now retain a higher number of toner alerts without influencing the other toner alerts that are sent.

17. For HP LaserJet P4014, HP LaserJet P4015, and HP LaserJet P4515 devices, SSL/TLS support can now be configured.

18. On the final page of the Edit Solution wizard, the Edit button has been changed to the Apply button.

19. HP Web Jetadmin now allows a limit of 300 for the Job Storage Limit configuration option. This configuration option is available in the Device category on the Config tab.

20. For HP legacy devices, HP Web Jetadmin now displays all of the values for fax notifications in a new device list column called Condition upon which to notify (Oz/Legacy). This new column is available in the first level of the tree in the Select Columns window. For other devices, the Condition on which to notify column is still available as a subcolumn of Fax Receive Settings.

**HP Web Jetadmin 10.3 SR7 (10.3.93994)**

The following are the improvements and fixes made in HP Web Jetadmin 10.3 SR7 (10.3.93994):

1. After upgrading to HP Web Jetadmin 10.3 SR7, templates that were missing the Display Print Page on Information Tab setting will now show the Display Job Log on Information Tab setting.

2. All of the settings that were previously available on the Simple Power Management for One Watt configuration option were moved to the new Sleep Timer Settings configuration option in HP Web Jetadmin 10.3 SR6. After upgrading to HP Web Jetadmin 10.3 SR7, templates that had the Simple Power
Management for One Watt configuration option enabled will now show the Sleep Timer Settings configuration option.

**HP Web Jetadmin 10.3 SR6 (10.3.93671)**

The following are the improvements and fixes made in HP Web Jetadmin 10.3 SR6 (10.3.93671):

1. When deleting HP FutureSmart devices that have a device communication error, the devices are now deleted without an abnormal delay.
2. For the HP Color LaserJet CP4525 and HP Color LaserJet CP4025 toner cartridges, the Supply Usage report now displays the correct values for the Average Supply Coverage % fields.
3. The startup time for the HP Web Jetadmin client and the initial navigation through the software when a high number of device groups is present has been decreased. In addition, users are no longer required to change the Region and Language settings to English to gain the best performance.
4. During device discoveries, the use of some SNMP packets without a Community name has been known to trigger alarms on some UPS devices or generate traps on some HP devices, such as the HP LaserJet 1522mfp. This issue has been fixed by sending SNMP packets with a Community name during device discoveries.
5. HP Web Jetadmin no longer requires a default From address if the user's address is selected when configuring the Scan to Email feature.
6. When upgrading from HP Web Jetadmin 10.3 SR1 to HP Web Jetadmin 10.3 SR3, SR4, or SR5, the group filters reflected the GUIDs instead of the actual group names. When upgrading from HP Web Jetadmin 10.3 SR1 through SR5 to HP Web Jetadmin 10.3 SR6, the group filters reflect the actual group names with the full path.
7. For HP FutureSmart devices, the **Auto, Mixed A3/A4, and Mixed Letter/Ledger** settings for the **Default Original Media Size** configuration option can now be set correctly in HP Web Jetadmin. This configuration option is available from the **Copier** category on the **Config** tab.
8. When a parent group is renamed, subgroups that use the **Contains item** option for the **Filter Function** and specify the name of the parent group are now updated automatically.
9. For HP FutureSmart devices, support has been added for the **LDAP Name Attribute** column. This column is available under the **Windows Sign In Setup** column.
10. Discovery history can now be deleted successfully without the HP Web Jetadmin client crashing.
11. Link speed values are now reported correctly for devices that are connected at 1000T.
12. For the HP LaserJet M9050 MFP, HP LaserJet P4015, HP LaserJet M5035 MFP, and other affected HP devices, the Supply Replacement Forecast report now lists the Maintenance Kit, Transfer Kit, and Drum Kit information.
14. For the HP LaserJet MFP M725, the **Display Options on Information Tab** configuration option is now available from the **Security** category on the **Config** tab.
15. If a PC-connected device is initially discovered via HP SNMP Proxy Agent, the device can now be rediscovered via another proxy server. This means that devices, such as the HP LaserJet M401, display the toner information correctly after a rediscovery, even if the device was initially discovered via HP SNMP Proxy Agent.
16. HP Web Jetadmin now allows the ampersand (&) character in the search root when configuring LDAP authentication. This matches the functionality in the HP Embedded Web Server (EWS).

17. The T37 prefix setting on the Fax Send Settings configuration option now allows the equal sign (=) character. This configuration option is available from the Fax category on the Config tab.

18. In a DHCP environment, HP Web Jetadmin no longer changes the hostname if a printer is turned off and another device uses the printer’s IP address.

19. For the HP Color LaserJet 700 M725, the Inactivity Timeout configuration option is now available from the Device category on the Config tab.

20. When templates that contain passwords are renamed, the settings are applied successfully, and HP Web Jetadmin no longer continues asking for credentials.

21. For the SMTP Gateway Settings configuration option, 16 MB, 24 MB, and 32 MB options have been added for the Maximum attachment size setting. The SMTP Gateway Settings configuration option is available from the Digital Sending category on the Config tab. When other values are set for the Maximum attachment size setting, HP Web Jetadmin can still configure the SMTP gateway settings.

22. Subscribing to drum alerts is now possible for devices that are supported with the HP Enterprise MFP UPI or HP Enterprise UPI, such as the HP Color LaserJet Enterprise flow MFP, HP Color LaserJet Enterprise M880, HP Color LaserJet Enterprise M855, and HP Color LaserJet Enterprise MFP M680.

23. When downloading firmware bundles to the repository, users can select several firmware files to download at the same time. If a selected firmware file is missing on the FTP server, HP Web Jetadmin no longer stops the entire download process.

24. For various HP FutureSmart devices, the Status tab and Status column now report In Deep Sleep instead of STATUS_IN_DEEP_SLEEP.

25. Importing groups is now faster. The Parent group button in the Import Groups wizard now works consistently.

26. When a user exports column data and selects the Email option as the destination, HP Web Jetadmin no longer stores a copy of the report in the following directory:

```
C:\Windows\ServiceProfiles\NetworkService\AppData\Local\Hewlett-Packard\HPWebJetadmin\WjaService\Export
```

27. When applying a device configuration template that includes the LDAP Settings configuration option to the HP LaserJet Enterprise 500 MFP M525 and HP LaserJet Enterprise 500 Color MFP M575 devices, HP Web Jetadmin displays a result of Invalid Data. To match the behavior of the EWS, HP Web Jetadmin no longer allows users to select both the Simple option for the LDAP server authentication setting and the Use MFP user credentials to connect after sign in at the control panel checkbox and requires a username for the LDAP settings.

28. The HP LaserJet 4350 device does not support the Time Services configuration option. HP Web Jetadmin no longer shows it as a configurable option for this device.

29. When copying a search root directory into a new template, the text (not specified) no longer remains in front of the search root entry.

30. After renaming a template that contains a password, the templates could no longer be used because HP Web Jetadmin kept asking for credentials. HP Web Jetadmin now maintains the password information in a template after the template is renamed.
HP Web Jetadmin 10.3 SR5 (10.3.91358)

HP Web Jetadmin 10.3 SR5 (10.3.91358) added monitoring support for the new HP Enterprise S Series class of MFP color and monochrome devices. No additional improvements or fixes have been included in this release. Configuration options for the new HP Enterprise S Series class of MFP color and monochrome devices will be offered in a later release. Users who have already installed HP Web Jetadmin 10.3 SR4 on a production server should carefully consider the necessity of upgrading to HP Web Jetadmin 10.3 SR5 due to the aforementioned minimal changes between HP Web Jetadmin 10.3 SR4 and HP Web Jetadmin 10.3 SR5.

HP Web Jetadmin 10.3 SR4 (10.3.90613)

The following are the improvements and fixes made in HP Web Jetadmin 10.3 SR4 (10.3.90613):

1. Optimization improvements have been made for Simplex/Duplex reporting. The Total Blank Impression value is now properly displayed in the Device Utilization report.
2. When a third-party solution is installed, HP Web Jetadmin correctly displays the SecureJet Access Control and SecureJet Enrollment Agent options in the Access Control for Device Functions configuration option.
3. Multiple solution templates can be created with different configuration URL values.
4. The export and import functionality for configuration templates that contain user-defined fields is no longer blocked in HP Web Jetadmin. This means that templates with user-defined fields can be exported and imported successfully only on a single HP Web Jetadmin installation.
5. Editing a device configuration template no longer causes the User Editable checkboxes on the Quick Sets configuration option to be selected again.
6. For HP LaserJet Enterprise 500 MFP M525 devices, the Quick Sets metadata file format now displays correctly.
7. Quick Sets now display in HP Web Jetadmin in the same order that they display in the HP Embedded Web Server.
8. Users can now export the values and details for the Home Screen Applications configuration option.
9. For HP LaserJet M-Series MFP devices, the device value load times work properly.
10. For HP LaserJet Enterprise 700 color MFP M775 devices, the Device Utilization by User report can now be generated.
11. The Enable Send to Email functionality can now be set and configured properly in HP Web Jetadmin.
13. For several HP Jetdirect cards, Link Speed support has been added.
14. For HP FutureSmart devices, the Sleep Delay Time configuration option can now be properly configured.
15. For HP Color LaserJet CM6040MFP devices, the Fax Number Confirmation configuration option is available.
16. For HP FutureSmart devices, various fax configuration options can now be set correctly.
17. For HP Color LaserJet CP3525, P3015, and P4015 devices, HP Web Jetadmin can set a PJL password with a much wider range.
18. HP Web Jetadmin no longer removes Home screen applications that should be left unchanged during configuration.
19. New auto group filters that are defined as Device Group Contains Item <subgroup> now populate correctly. However, existing filters must be edited and the subgroup must be reselected. The full path to the subgroup is included in an existing filter only after reselecting the subgroup and saving the filter.

20. The LAN Fax Service Settings configuration option no longer disappears. In addition, the Condition on which to notify list retains the default value of Do not notify when the Fax Notification configuration option is configured with the following options via the HP Embedded Web Server and HP Web Jetadmin:

- For Send faxes only
- For Errors on Sending faxes
- For Errors on Receiving faxes


21. Re-applying Quick Sets on an HP device no longer fails if one of the Quick Sets requires a password.

22. Users can enable and disable the FTP Printing setting on the Network Enable Features configuration option. This configuration option is available in the Network category on the Config tab.

When FTP is enabled on HP LaserJet M4345 MFP devices, the FTP Printing setting is available in the list of network features in HP Web Jetadmin. When FTP is disabled on these devices, the FTP Printing setting is now also available in the list of network features.

23. After running the restore.bat file under WJABackupRestore, the .dat file is no longer deleted from the C:\hpwja_backup directory.

24. The default timeout for firmware upgrades has been changed from 1 hour to 2 hours to increase the success rate of firmware upgrades on slower networks.

25. For legacy HP LaserJet devices, fonts and macros that have file names that are more than 50 characters can now be applied.

**HP Web Jetadmin 10.3 SR3 (10.3.88120)**

The following are the improvements and fixes made in HP Web Jetadmin 10.3 SR3 (10.3.88120):

1. The EWS Information Page Protection configuration option has been added for the HP Color LaserJet CP4520 Series. This option is available in the Security category on the Config tab.

2. Users can enter special characters in the User name field on the Fax Send Settings configuration option. This option is available in the Fax category on the Config tab. To configure the user name, select the Enable fax send checkbox, select LAN Fax Service from the Fax send method list, and then enter the user name information in the Folder Settings section.

3. Optimized code has been added to HP Web Jetadmin 10.3 SR3 to enhance performance when devices are deleted from automatic groups.

4. When configuring an Access Control List (ACL), HP Web Jetadmin now sends the IP address and subnet mask together. In previous versions, HP Web Jetadmin sent the IP address in a separate package and the printer automatically added a subnet mask of 255.255.255.255. This method blocked HP Web Jetadmin from accessing the printer if the first IP address was not the IP address of the HP Web Jetadmin server. Now HP Web Jetadmin can configure custom subnet masks.
The **Access Control List** configuration option is available in the **Security** category on the **Config** tab. The first item in the ACL must be the IP address of the HP Web Jetadmin server or an IP address with a wide subnet mask that includes the IP address of the HP Web Jetadmin server.

5. When setting or modifying the **Duplex Binding** configuration option for the HP LaserJet 600 Series, users are no longer prompted to enter HP Embedded Web Server (EWS) credentials. This option is available in the **Device** category on the **Config** tab.

6. For HP FutureSmart MFPs, when a user configures the **Enable Send to Email** option, but does not configure the **Outgoing Server** option and configure the **Default from** setting on the **Email Address/Message Settings** option, HP Web Jetadmin now reports an error message instead of claiming success when nothing was configured.

7. Previously, HP Web Jetadmin did not accept special characters when setting up LDAP authentication on the HP LaserJet M4555. This has now been fixed. In the HP Embedded Web Server (EWS), you can specify two LDAP servers, separated by the pipe symbol (|).

8. The **Media Type Administration** configuration option is now available for the HP LaserJet 700 M712 and HP LaserJet 700 color MFP M775. This option is available in the **Device** category on the **Config** tab.

9. After upgrading to HP Web Jetadmin 10.3 SR3, automatic groups that contain filters that also contain device groups work correctly. Previously, the upgrade to HP Web Jetadmin 10.3 SR2 resulted in broken subgroups.

10. The **Inactivity Timeout** configuration option is now available for the HP Color LaserJet 700 M775. This option is available in the **Device** category on the **Config** tab.

11. The Cartridge Very Low and Fuser Very Low alert messages are no longer triggered when the printer door is opened on HP Color LaserJet CM3530 MFP, HP Color LaserJet CM6040 MFP, and HP LaserJet M9050 MFP devices.

12. Users can now correctly configure and edit the **Home Screen Language Selection** configuration option by using configuration templates.

13. The **LDAP Settings** configuration option can now be configured successfully in batch mode for HP FutureSmart devices. This option is available in the **Digital Sending** category on the **Config** tab.

14. HP Web Jetadmin has been modified to correctly reflect the image drum installation date and other details in the columns and reports for the HP Color LaserJet CM6040 MFP.

15. When a user applies the **LAN Fax Service Settings** configuration option in HP Web Jetadmin to a device, the **Send Fax as LAN Fax Service** option on the device itself is now also set. When a user applies the **Fax Modem Settings** configuration option in HP Web Jetadmin to a device, the **Send Fax as directly from the device's internal modem** option on the device itself is now also set. The **LAN Fax Service Settings** and **Fax Modem Settings** configuration options are available in the **Fax** category on the **Config** tab. This code change applies to legacy HP LaserJet MFP devices.

16. The Edit functionality and configuration process of the Pharos solution installer is now working correctly.

17. The **Resend Upgrade** value has been removed from the **Status** category in the **Filter Editor**.

18. HP Web Jetadmin no longer displays an error when users import .jar files by using the **Device Management > Solutions > Repository** feature.

19. The **Captaris RightFAX-HP MFP Module** option is now available from the **Third party LAN fax product** list on the **Fax Send Settings** configuration option. This option is available in the **Fax** category on the **Config** tab.

20. HP Web Jetadmin 10.3 SR3 now displays the correct device image for the HP LaserJet Enterprise flow MFP M525c.
21. HP Web Jetadmin no longer displays an error when an Auto Cleaning Page template is applied to an HP Color LaserJet Enterprise CM4540 MFP that has an Input Output Filter (IOF) based solution installed.

22. In HP Web Jetadmin 10.3 SR3, a Communication Error no longer occurs when the user selects a device in a device list, clicks the Solutions tab, initiates the Edit Solution wizard, and then selects the Unset option.

23. Media types are now sorted in the correct order in template mode.

24. Users can now successfully subscribe to the Transfer Kit Supply Threshold alert on the HP Color LaserJet CP4525.

**HP Web Jetadmin 10.3 SR2 (10.3.86392)**

The following are the improvements and fixes made in HP Web Jetadmin 10.3 SR2 (10.3.86392):

1. Third-party applications that are saved to a template by using the single configuration method can now be selected in the Authentication Manager configuration option when applying the template to other devices if those third-party applications were selected for at least one function under Authentication Manager when the template was created.

2. Users can now select the LLMNR option on the Network Enable Features configuration option for HP LaserJet devices that support this feature. This configuration option is available in the Config tab > Network category.

3. Users can now correctly configure the WEP-Personal and WPA-Personal settings for the Jetdirect 2700w when HP Web Jetadmin is installed on a Japanese operating system.

4. HP Web Jetadmin correctly displays the Email Address/Message Settings column status for HP LaserJet MFPs and HP Color LaserJet MFPs that support this feature. This configuration option is available in the Config tab > Digital Sending category.

5. The Control Panel Display configuration option now appears correctly for HP FutureSmart devices. This configuration option is available in the Config tab > Device category.

6. Firmware upgrades can now optionally be instructed to bypass the status-checking portion of the upgrade to improve performance and allow for many more upgrades to be sent in a given time period. Instead of waiting for successful completion of the entire upgrade, HP Web Jetadmin now claims success as soon as the image is delivered to the device, allowing for subsequent images to be sent earlier. For more information about enabling this feature, see the white paper titled Upgrading Firmware using HP Web Jetadmin. This white paper is available from the HP Support Center.

7. The Pharos Print Release option is now available in HP Web Jetadmin from the Config tab > Device category > Home Screen Applications configuration option for HP FutureSmart devices that support this feature.

8. When a user creates a filter of Device Group - Contains Item - select group from drop-down of known groups, HP Web Jetadmin now writes a group name instead of a group GUID into the XML. This change allows the group import/export function and filter to work properly.

9. The SMTP Server column now appears under the Device category instead of the Obsolete category.

10. For the HP OfficeJet Pro 8100, the Print Usage counters no longer display <Unknown> and now reflect the correct values in HP Web Jetadmin. Predecessor device models displayed these counters correctly.

**HP Web Jetadmin 10.3 SR1 (10.3.85669)**

The following are the improvements and fixes made in HP Web Jetadmin 10.3 SR1 (10.3.85669):
1. When a user creates Save to Folder Quick Sets and saves them in a template, the Quick Sets are created in alphabetical order and then sent to the device. However, when the Quick Sets reach the device, they are displayed in random order. To change the order of the Quick Sets, users must use the HP Embedded Web Server on the device or use the A-Z button on the control panel each time they want to send a document using the Quick Sets. This issue applies to HP FutureSmart devices. Users can now specify the order of Scan to Folder Quick Sets in the HP Web Jetadmin template.

2. The **Access Control List** section in the template wizard does not match the **Access Control List** section for the configuration of a single device. Users cannot add more than one address to the list when using the template wizard. The workaround was to use the single configuration and apply it to different device models. Users can now add multiple addresses in the template wizard for **Access Control List** for HP LaserJet devices.

3. For the HP Color LaserJet CM4540 MFP Series printers, HP Web Jetadmin does not allow certain characters to be entered in the **LDAP Server Settings** configuration option. The workaround was to use the HP Embedded Web Server on the device to enter the characters. HP Web Jetadmin now allows special characters within the LDAP server configuration for the HP Color LaserJet Enterprise CM4540 MFP.

4. Users were unable to upload multiple PJL files by using the **PJL Configuration** configuration option. The only way users were able to send multiple configurations via PJL configuration was to combine all the PJL statements into a single file. Users can now upload and send multiple PJL files via the **PJL Configuration** configuration option in HP Web Jetadmin.

5. When using HP Web Jetadmin to uninstall the Softbutton (eMail) solution on an HP LaserJet M3035 MFP, HP Web Jetadmin reports an error. However, the uninstallation completes properly. This reporting error in HP Web Jetadmin has been resolved.

6. Customers have reported that when applying a template to an HP Color LaserJet M4555 MFP that supports the **Open/Print from USB Device** configuration option, the template shows this configuration option as **<Not supported>**. However, the specified setting for that option is applied to the device successfully. Now, when applying a template to the HP Color LaserJet M4555 MFP, the template no longer shows this option as **<Not Supported>**.

7. **802.1x/PEAP** now works correctly with the HP Color LaserJet Enterprise CM4540 MFP when configured using HP Web Jetadmin.

8. For HP FutureSmart MFPs, the value in the **Fax Header Settings** column was **Items: 3** instead of the actual fax number or **<Fax Header Fax Number>**. The **Fax Header Settings** column now displays the fax number correctly.

9. For the HP OfficeJet Pro 8600, the **Print Usage** counters no longer display **<Unknown>** and now reflect the correct values in HP Web Jetadmin. Predecessor device models displayed these counters correctly.

10. In certain configurations, the client or server might hang for long periods of time when selecting groups or creating and editing templates. The system might become unresponsive. This issue might occur on both the client and the HP Web Jetadmin server. Improved code has been added to HP Web Jetadmin to avoid redundant processing of the templates and improve performance.

11. The **Toner Density** option has been added to HP Web Jetadmin for the following products:

    - HP LaserJet M425 MFP
    - HP LaserJet 500 MFP M525
    - HP LaserJet Enterprise 600 Series M601
    - HP LaserJet Enterprise 600 Series M602
12. The correct product images have been added to HP Web Jetadmin for the following products:
   - HP LaserJet Enterprise 600 Series M603
   - HP LaserJet Pro 400 MFP M425
   - HP LaserJet Pro 400 M401

13. Additional Access Control options are now available in the Security configuration section of the template wizard for HP FutureSmart devices.

14. The Approximate Percent Remaining column in HP Web Jetadmin now correctly reflects 100% instead of Not Supported for certain HP LaserJet devices as it does in the HP Embedded Web Server.

15. The HP Web Jetadmin configuration template correctly displays all characters at a screen resolution of 1280 x 1024.

16. HP Web Jetadmin now reflects the correct values under the Engine Cycle Count column for the HP LaserJet 400 M401.

17. Under the Fax Header configuration option, users can now modify the company name and phone number independently for various HP FutureSmart and legacy LaserJet devices.

18. The Device Disconnected alert is now available for HP LaserJet 400 M401.

19. When using HP Web Jetadmin to set the Group 1 PIN code for HP LaserJet MFPs that are connected to DSS servers, HP Web Jetadmin no longer reports the error This device is being serviced by Digital Sending Software.

20. On HP LaserJet M600 devices, when attempting to change the mode of the 5-bin mailbox from one mode to the Function Separator mode, HP Web Jetadmin no longer displays the error message Invalid Data when attempting this configuration: "High Capacity Output Mode > Function Separator> Invalid data".

**HP Web Jetadmin 10.3 (10.3.83654)**

The following are the improvements and fixes made in HP Web Jetadmin 10.3 (10.3.83654):

1. For the HP DesignJet Z6100PS Printer Series, the status is now shown correctly when a roll of paper is loaded in the device.

2. For an HP LaserJet printer, configuring the Envelope #10 setting of the Paper Tray Assignments configuration option now reports a successful configuration.

3. For the HP LaserJet 4000 Series printers, the current tray configuration is now shown correctly.

4. For various HP LaserJet single-function and multifunction printers, Tray 4 now displays correctly on the Capabilities tab.

5. When an HP Jetdirect 635n card is installed, various Digital Send and Security configuration options are no longer missing in HP Web Jetadmin.

6. SQL Server 2005 Express no longer generates random log files.
7. When uploading macros to the repository, HP Web Jetadmin now extracts macro IDs if they are present in the file.

8. When certain macros are pushed to the device, the file no longer appears incorrectly as a font when viewed in HP Web Jetadmin.

9. For the HP LaserJet P3015 printer, the **Time Zone** configuration option is now enabled.

10. For the HP Jetdirect J8003E (v.48.06 and later), the encryption strength now matches the encryption strength found in the HP Embedded Web Server.

11. For the HP Color LaserJet CM6040 MFP, supply gauge information now displays correctly.

12. The reference to ipptool.exe that appears in the log file after upgrading HP Web Jetadmin has been identified and resolved.

13. For the HP Color LaserJet CM6040 MFP, the tray size and type administration is now working correctly.

14. The following **Supply** columns have been moved from the **Obsolete** category to the **Supplies** category:
   - Document Feeder Kit
   - Drum Spittoon
   - Web Wipe
   - Stapler, Stapler (Secondary), and Stapler (Tertiary)
   - Toner Collection Unit

15. Users can now toggle the **Enable DHCPv4 FQDN compliance with RFC 4702** configuration option in the **Network** category.

16. For the HP LaserJet P2055 printers and HP Jetdirect J8017E, the **System Contact** configuration option in the **Network** category is now available.

17. Users can optionally connect to a remote SQL server by using a port other than default port 1433.

18. Administrators can now set a password for the LAN fax folder.

19. For the HP LaserJet Enterprise 600 M603 Series printers, administrators can now configure custom media types.

20. On the **Status** tab, the German translation of **Hardware Address (MAC)** has been corrected.

21. For the HP Color LaserJet Enterprise CM4540 MFP users can now apply Quick Sets when the **One Touch** option is selected and the **Default From** is not specified.

22. In the **Tools > Options > Shared > Server Maintenance > Configuration** option, if the Retention time option is set to 1 day, the configuration history is now removed successfully.

23. For the HP OfficeJet Pro 8600 and HP OfficeJet Pro 8000 Enterprise A811a printers, correct values are now displayed in the **Engine Cycle Count** column.

24. The SMTP hostname now allows underscores in the name for devices that support SMTP Gateway settings.

25. For the HP LaserJet P4014, P4015, and P4515 Printers and HP LaserJet Enterprise 600 Printer M60X Series, support for the 5-Bin mailbox has been added.
26. For the HP LaserJet P3015 printer, the supply level detail in the device list and Status tab now updates correctly after the toner is replaced.

27. URL validation now properly evaluates the Model Name macro when configuring a URL in HP Web Jetadmin.

28. The DatabaseSettings.config.xml file is now shipped with HP Web Jetadmin.

29. License Manager correctly accepts the entire valid license when using the copy/paste function.

30. For HP FutureSmart devices, the System Name configuration option can include underscores.

31. Minor code changes have been made to resolve an issue with the HP Embedded Web Server/admin password not being set correctly after it has been set by applying an HP Web Jetadmin template. This issue applies to legacy HP LaserJet devices.

32. For HP FutureSmart devices, the Access Control templates now correctly lock items.

33. For the HP Color LaserJet CP4520 Series Printers, users can now set the consumable threshold settings.

34. For the HP Color LaserJet CP4525, CP4025, CP3525, and CM3530 MFPs, the Contact Person configuration option in the Device category has been added.

**HP Web Jetadmin 10.2 SR7 (10.2.80493)**

The following are the improvements and fixes made in HP Web Jetadmin 10.2 SR7 (10.2.80493):

1. Imported configuration templates no longer drop values for items that contain the same name.

2. The SNMP Version Access Control configuration option no longer requires a reset of the credentials.

3. HP Web Jetadmin has increased the number of characters supported for the device asset number from 8 characters to 32 characters.

4. HP Web Jetadmin now supports color impressions for the HP Color LaserJet CP3525 and CP4520 devices.


6. Data collection for the HP LaserJet CM8060 MFP and similar models no longer fails after upgrading to HP Web Jetadmin 10.2 SR5 Hotfix.

7. In the Security configuration category, the Encryption Strength configuration option is no longer blocked for HP Jetdirect (J6057A).

8. When creating or editing templates, client crashes that result in an Unexpected Error no longer occur when you select a Sign In Method option for E-mail application.

9. The numbers provided in the Groups category in Reports are now shown correctly.

10. The Access Control for Device Functions configuration option no longer fails with an Invalid Data error.

11. The Access Control for Device Functions column is now populated correctly for various HP LaserJet devices.

12. New calculation algorithms have been implemented for the Supply Replacement Forecast report.

13. The HP Web Jetadmin installer no longer aborts if port 8000 is in use.

14. Additional filtering logic has been implemented to provide the correct IP status for devices that have been replaced and show as Unknown in HP Web Jetadmin.
15. HP Web Jetadmin no longer incorrectly blocks the **Bootloader Password** configuration option for the HP Color LaserJet 3800, 4700, CP3505, and CP3525 devices.

16. When using a group policy to upgrade device firmware, HP Web Jetadmin no longer upgrades device firmware if the same version of firmware is detected and already installed on the device.

17. Setting the number of ping retries is now a configurable item as part of discovery in HP Web Jetadmin.

18. DST settings are now a configurable item on the HP LaserJet P3015.

19. Supply columns have been enabled for the HP Color LaserJet CM3530.

20. The **Estimated Pages Remaining** column has been enabled for the HP Color LaserJet CM6040.

21. The **Estimated Pages Remaining** column for black toner has been enabled.

22. The **Estimated Pages Remaining** column now show labels correctly.

23. HP Web Jetadmin now sends alerts for **Cartridge Very Low** events.

24. The **Print PS Errors** configuration option has been enabled for the HP LaserJet 4345 MFP.

25. The **Daylight Saving Time** configuration option has been enabled for the HP Color LaserJet 4730 MFP.

26. In the **Digital Sending** configuration category, the **Username** option in the **LDAP Settings** configuration option now allows the comma (,) and backslash (\) extended characters.

27. The fax settings for the HP Color LaserJet CM4540 MFP are now configured correctly when the dollar sign ($) symbol is used.

28. The **Send to Network Folder** functionality is now working correctly with legacy HP LaserJet MFP devices.

29. The **Tray Administration** configuration option has been enabled for HP Color LaserJet CP4520 series devices.

30. For the **Kerberos Authentication** configuration option, the first domain in the list is now considered the default if it is not specified by the user.

31. Equitrac and other authentication solutions are now available in the **Access Control for Device Functions** configuration option.

32. The HP LaserJet 4050 and HP LaserJet 8150 now report total pages on the color/mono report.

33. The **System Contact** and **System Location** configuration options are now available in the **Network** category on the **Config** tab.

34. HP Web Jetadmin now allows the discovery of devices using hostnames that begin with a number.

35. Supply utilization data collections are now successful when using introductory cartridges in the HP OfficeJet 8500A Plus.

36. The **Envelope #10** option in the **Paper Tray Assignments** configuration option no longer fails for the HP Color LaserJet CP3525 and other device models.

37. For JDI models (J7993E, J8003E, J8004E, J8011E, J8013E, and J8017E), the **TCP/IP Domain Suffix** configuration option is no longer missing.

38. Lexmark printers no longer show a device status of **Device Communication Error** in HP Web Jetadmin when a paper tray is empty.
The following are the improvements and fixes made in HP Web Jetadmin 10.2 SR6 (10.2.77156):

1. HPWSProAdapter Service memory consumption no longer increases with the addition of new devices. Older versions increased memory usage proportionally. Newer versions consume much less memory when new devices are discovered.

2. HP Web Jetadmin now installs the HPWSProAdapter Service correctly on Windows 2008 R2 SP1 and Windows 7 SP1 systems.

3. Reports, Data Collection now allows the removal of devices marked Unknown.

4. A PC-connected discovery now correctly populates devices in the All Devices list.

5. HP Web Jetadmin no longer uses a system proxy setting for Network Service when communicating with devices through Web Services (WS).

6. The HP Web Jetadmin internal task management does not become overloaded when a customer activates a large number of scheduled discoveries.

7. The HP Web Jetadmin silent installation now successfully executes on 64-bit operating systems. New installer Help details are available in the HP Web Jetadmin 10.2 Installation and Setup Guide or the HP Web Jetadmin 10.2 User Guide. To access this help in the software, go to HP Web Jetadmin 10.2 > Installation and Setup Guide for HP Web Jetadmin 10.2 > Installing HP Web Jetadmin 10.2 from a Command Line or Script.

8. The Alerts subscriptions removal issue has been corrected on non US-English operating systems that use a collation setting other than SQL_Latin1_General_CP1_CI_AS. HP Web Jetadmin now sets the instance default to match the SQL instance used to adopt the OS setting.

9. The Toner Coverage column now appears correctly in the Supplies category in the column settings.

10. The IPv6 setting now correctly disables this functionality at the device.

11. In HP Web Jetadmin 10.2 SR5, the IPv6 and configuration precedence settings were implemented as a single configuration option. These settings have now been separated.

12. The Color Access Control configuration option now allows 250 entries.


15. HP Web Jetadmin is now able to delete multiple stored print jobs.

16. The Maps issue is now corrected. In some cases, deleted device group maps might cause an abrupt client closure.

17. The Active Directory attributes are now updated correctly after consecutive Active Directory discoveries.

18. For Secure Storage Erase operations, IP addresses are now correctly included in the HP Web Jetadmin application log. For more information about this functionality, see the related HP Web Jetadmin support documentation at www.hp.com.

20. HP Web Jetadmin now correctly paints tabbed work areas and navigation areas when the client UI is brought back from being minimized.

21. Changed settings on the Digital Sending – Accessing the LDAP Server configuration option are now corrected and stored successfully on the device.

22. The SNMP Trap Generator now correctly populates the Agent-addr Trap Field in the UDP packet on HP Web Jetadmin hosts that have multiple NICs.

23. The Capabilities, E-mail column now reflects correctly for the HP LaserJet M3035 MFP series.

24. HP Web Jetadmin 10.2 SR6 now functions correctly when installed on the same Windows host as HP Digital Sending Service (DSS). In the previous two releases of HP Web Jetadmin, HP Web Jetadmin and/or HP DSS failed when both were installed on the same Windows host. Fixes have been added to HP DSS version 4.91.21 and HP Web Jetadmin 10.2 SR6 (10.2.77156) that allow the two applications to exist on the same Windows host. The older versions of HP Web Jetadmin 10.2—SR5 (10.2.73942) and SR5 Hotfix (10.2.74918)—will function correctly with HP DSS version 4.91.21 or later. In addition, HP Web Jetadmin 10.2 SR6 (10.2.77156) will function correctly with all versions of HP DSS when installed on the same Windows host.

To achieve optimal performance, customers should continue to dedicate a Windows system that hosts HP Web Jetadmin in production environments.

**HP Web Jetadmin 10.2 SR5 (10.2.73942) and SR5 Hotfix 1 (10.2.74918)**

The following are the improvements and fixes made in HP Web Jetadmin 10.2 SR5 (10.2.73942) and SR5 Hotfix 1 (10.2.74918):

1. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** HP Web Jetadmin 10.2 (10.2.74918) now installs on Windows 7 SP1 or Windows Server 2008 R2 SP1 hosts. In the earlier SR5 (10.2.73942), HP Web Jetadmin failed to install with the following message: "Error 1920. Service HPWSProAdapter (HPWSProAdapter) failed to start. Verify that you have sufficient privileges to start system services." At this time, the installer finishes and HP Web Jetadmin starts correctly with the following exception.

On Windows 7 SP1 or Windows Server 2008 SP1, the HP Web Jetadmin component HPWSProAdapter does not start, leaving the following HP models unmanageable:

- HP OfficeJet Pro 8500A e-All-in-One Printer series
- HP OfficeJet Pro 8000 Enterprise Printer
- HP LaserJet Pro CP1525 Color Printer series
- HP LaserJet Pro M1536dnf MFP
- HP LaserJet Pro CM1415 Color MFP series

These HP models are, however, manageable on HP Web Jetadmin 10.2 SR5 versions that are installed on Windows 7 and Windows Server 2008 hosts that have not had R2 updates. Also, these HP models had limited management functionality in HP Web Jetadmin 10.2 SR4. If HP Web Jetadmin 10.2 SR5 Hotfix 1 is installed on a Windows 7 or Windows Server 2008 host with SP1 updates, these HP models will be discovered and displayed with a Device Communication Error status. These HP models will continue to display that status and cannot be manageable from HP Web Jetadmin 10.2 hosted on a Windows 7 or Windows Server 2008 host with SP1 updates.
If you want to manage these HP models, HP recommends that you run HP Web Jetadmin 10.2 SR5 on a Windows 7 or Windows Server 2008 host without SP1 updates. HP is investigating this issue and will provide a resolution in a future release.

2. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** The Digital Send, Send to Network Folder, and Kerberos columns are now returned to the Column and Filter selection interfaces. These items were missing in HP Web Jetadmin 10.2 SR5.

3. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** For the HP Color LaserJet CM6040 MFP and some other models, the supply level gauges now consistently appear in the HP Web Jetadmin status interface and the level values appear in the related supply columns. In SR5, these items intermittently did not appear. This issue is corrected in the hotfix.

4. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** User-defined device settings that are stored in the HP Web Jetadmin configuration area now appear correctly in the configuration area. Previously, these device settings appeared in the configuration area with a GUID string rather than the name and failed to appear in the device list columns and filters settings.

5. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** The HP Web Jetadmin Service fails to start after upgrading to SR5 from an earlier SR. This issue was characterized on non-U.S. regionalized Windows systems. SR5 Hotfix 1 corrects this issue by simply installing it on a system that has the service startup failure. Otherwise, this issue is corrected in the hotfix.

6. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** The J7922E network configuration now correctly shows the TCP/IP Idle Timeout configuration option and other network options.

7. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** For newer device models (HP LaserJet Professional CP1521n Series, HP LaserJet Professional CM1411fn Series, and HP LaserJet Professional M1537dnf MFP), model variations now appear correctly when a discovery is performed after upgrading to HP Web Jetadmin 10.2 SR5 Hotfix 1.

8. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** Accessory Inventory Reports now function correctly for HP OfficeJet Pro 8000 Enterprise A811a devices.

9. **HP Web Jetadmin 10.2 SR5 Hotfix 1 and newer versions ONLY!** Introductory supplies are now correctly represented in HP Web Jetadmin for HP OfficeJet Pro 8000 and HP OfficeJet Pro 8500A devices. Ink levels for these supplies were not displayed in SR5.

10. In a PC-connected discovery, the display name for non-HP devices has been corrected.

11. Data Collections counts (navigation tree versus Reports Collections workspace) have been corrected.

12. The **DHCPv4 FQDN compliance with 4702** configuration option has been added for the HP LaserJet P3015.

13. The **PS Defer Media** configuration option has been added for the HP Color LaserJet CP3525 and HP LaserJet P4015.

14. The **PCL Form Length** configuration option has been added for the HP Color LaserJet CP3525 and HP LaserJet P4015.

15. The **HTTP Idle Timeout** configuration option has been added for the HP LaserJet P3015 and HP Color LaserJet CP3525.

16. The 64-bit and 32-bit versions of the Universal Print Driver (UPD) are now supported for uploads to the repository.

**NOTE:** For more information about the requirements for the Print Management features, see the HP Web Jetadmin 10.2 Installation and Setup Guide.
17. The SQL Connectivity Module License no longer needs to be re-applied after an upgrade.
18. Corrections have been made to the supplies messaging (for example, device lists, Supplies tab, and alerts).
19. The Supplies status no longer displays a level above 100% for the HP DesignJet L25500.
20. The Reset Device option is now offered for the HP Color LaserJet CM6040.
21. The <Unknown> issue within Alerts subscriptions has been corrected.
22. The HP LaserJet 8150 is now correctly listed in the repository with newer firmware upgrades with images.
23. The Supply Threshold alert is now triggered correctly for the HP LaserJet 8150.
24. Supply level display issues specific to the HP OfficeJet Professional 8500 Series have been corrected.
25. The overwrite issue for the Kerberos and LDAP authentication configuration settings has been corrected.
26. HP Web Jetadmin installed on a Japanese Windows environment now triggers various Alerts correctly. In the previous release, Paper Jam alerts were incorrectly triggered.
27. Preconfiguration issues with the Print Management driver have been corrected.
28. The Embedded Web Server Language Settings configuration option is now correctly configured for the HP LaserJet P3015. This issue occurred intermittently when the device asset number contained certain non-printing characters.
29. The Disk Jobs column in device lists now correctly displays the details for supported devices.
30. The Outgoing Mail enable/disable configuration has been corrected for the HP Color LaserJet CP4525.
31. The supply level display issue has been corrected for the HP LaserJet P3015.
32. The correct IP address is now set in the device SNMP trap destination table when the HP Web Jetadmin host has multiple Network Interface Adaptors (NICs) and when HP Web Jetadmin has had a configuration file adjustment to direct the HP Web Jetadmin service to the correct NIC.

**NOTE:** For more information about the configuration of an HP Web Jetadmin installation on a host that has multiple NICs, see the *HP Web Jetadmin 10.2 Installation and Setup Guide*.

33. The Reports, Data Collections issue has been addressed for the HP LaserJet P3015s.
34. The fonts and macros upload issues have been corrected.
35. The LDAP configurations have been corrected for the HP Edgeline devices.
36. The Kerberos multi-domain configuration has been corrected. The device now correctly authenticates to all domains.
37. HP Web Jetadmin now correctly displays device-based fonts and macros.
38. The Print PS Error configuration option is now correctly offered for devices that support it.
39. The Supplies Threshold alerts are now correctly triggered for the desired level.
40. The device configuration timing issues for large configurations have been corrected.
41. Support for uploading HP Jetdirect certificates has been added for HP Jetdirect print server models J8013E, J8011E, and J8016E. HP Jetdirect model J7987E remains unsupported because it does not contain management objects.
42. The Supplies Report issues have been corrected. Several device models were reported in error when data had not been collected to cover the report requirement.

43. The Embedded Web Server Password configuration option now correctly shows <Not supported> for the HP Color LaserJet 2840. These devices do not contain the management objects that HP Web Jetadmin needs.

44. The TCP/IP Configuration Method configuration option is now offered for the HP DesignJet 9250c.

45. Firmware, Maximum Concurrent Upgrades now work in parallel rather than serial

46. The Any media type for the Paper Tray Assignments configuration option is no longer missing for the HP Color LaserJet CM3530 MFP.

47. The Date/Time device list column now displays the date and time value captured from the device. You might need to use the Refresh Selection option to match the column value to the device's date and time.

48. The EWS Information Protection configuration option is now available. Newer HP device firmware allows the Information tab in the device embedded web server to be locked via an administrator password.

49. The Address Book Management configuration option has been replaced by the new Import/Export Address Book configuration option, which allows importing and exporting both the fax number and email address details for HP MFP devices.

50. The Network, Other Settings, HP XML Services configuration option is now available for supported device models.

51. The HTTP Idle Timeout configuration option is now available for supported device models.

52. The PCL Form Length and PS Defer Media configuration options are now available for supported device models.

53. The DHCPv4 FQDN compliance with RFC 4702 configuration option is now available for supported device models.

54. The Override A4/Letter configuration option is now available for supported device models.

55. The Fax Maximum Baud Rate configuration option has been split into send and receive modes for supported device models.

56. The Digital Send configuration options now include Send to Email, Username, and Password for supported device models.

57. The Default Job Options, Default Options for Originals, and Heavy Originals configuration options have been added for supported device models.

58. The Default Job Options, Image Adjustment, and Background Cleanup configuration options have been added for supported device models.

59. The Total Legal Mono and Total Legal Color impressions counts no longer factor equivalent impressions. Equivalent impressions are available on any media size as a separate counter.

**HP Web Jetadmin 10.2 SR4 (10.2.71771)**

The following are the improvements and fixes made in HP Web Jetadmin 10.2 SR4 (10.2.71771):
1. The excessive false Paper Out alerts issue is addressed.

2. The NFS (File System External Access) column now correctly reflects the device feature state—Enabled or Disabled.

3. The Maintenance Kit Out alert is now correctly sent for true device conditions.

4. The HP Web Jetadmin service start failure that Microsoft Update for Root Certificates triggered is now corrected.

5. On the Config tab, the Default Original Media Size option in the Copier category now contains the Mixed LTR/LGL option for many HP MFP devices.

6. On the Config tab, the Paper Tray Assignments option is now offered for HP LaserJet P3005 Printer and HP Color LaserJet CM3530 MFP Series devices.

7. On the Troubleshoot tab, the Reset to Factory Defaults option is now correctly offered in the Reset Device wizard for applicable devices.

8. On the Config tab, the Duplex Binding option is now available for HP LaserJet 9040 Series and HP LaserJet 9050 Series devices.

9. On the Config tab, the Company Name option is now available for HP Color LaserJet CM3530 MFP Series devices.

10. On the Config tab, the Configuration Precedence option is now offered for all applicable HP Jetdirect and JDI models.

11. On the Config tab, the Home Screen Applications option now provides Create Stored Job functionality for applicable HP MFP devices.

12. On the Config tab, the Security category now offers the Bootloader Password option for HP LaserJet P4000 Printer Series devices.

13. On the Config tab, the Encryption Level option is now correctly offered for all applicable HP Jetdirect models.

NOTE: HP Jetdirect and printer firmware upgrades might be required.

14. For devices that are not communicating on the network, alerts messages now populate with cached device data rather than <Unknown>.

15. Font and macro IDs are now correctly extracted when a file is uploaded.

16. The Supplies Report now correctly handles duplicate toner serial numbers.

17. Data synchronization and cloning is now possible between 32-bit and 64-bit instances of HP Web Jetadmin without resulting in duplicate devices.

18. Secure Storage operations now correctly report the progress and results.

**HP Web Jetadmin 10.2 SR3 (10.2.66860)**

The following are the improvements and fixes made in HP Web Jetadmin 10.2 SR3 (10.2.66860):
1. For PC-connected devices, a discovery specific to the WMI protocol now takes less time.

2. A Help note and support documentation about configuration items that cause device interrupts is now available. A number of configuration items can cause devices to reset or become non-responsive. HP Web Jetadmin teams continue to study these items and documentation will be updated as new items are found.

3. The ampersand (&) character can now be used for OXPd URL string truncation.

4. The PJL configuration now functions correctly on all device models.

5. HP Web Jetadmin upgrades now recognize SQL HP Web Jetadmin installation file locations, and performs disk space requirement calculations appropriately.

6. In Supplies, the At Low, Black Cartridge operation is now available for HP LaserJet P3015 devices.

7. SMTP server validation now uses FQDN if one is provided at configuration.

8. Automatic Encrypted Drive Configuration is now available for HP LaserJet P3015 devices.

9. Encryption strength for HTTPS communication is now set correctly on HP LaserJet P3015, CM3530, and P4015 devices.

10. HP Web Jetadmin upgrades now increase the SQL timeout default to 120 seconds. You can manually adjust the setting for this in Tools > Options.

11. The Trap destination table no longer appears for HP LaserJet CP2025 devices because it is not a supported feature on these devices.

12. Duplicate supplies alerts no longer occur when HP devices are added to a group that has an Alerts policy.

13. Storage templates now function correctly on user-specified media.

14. Devices that HP Digital Send Service (DSS) manages are now allowed to display all configuration via the HP Web Jetadmin device list (specific configuration settings columns) or from the configure interface. Actual configuration of these items is still blocked while DSS control is in place.

15. Blocked configurations due to DSS-managed devices are now correctly indicated in results interfaces and configuration history.

16. Data collections for reports now succeed on most non-HP devices.

17. Client “unexpected errors” no longer occur when users display the device tab interface.

18. HP ScanJet Enterprise 7000n is no longer displayed as supporting an analog fax.

19. HP Web Jetadmin now caches IP Hostnames (obtained from the host Microsoft Windows operating system) for 24 hours. The host operating system can also cache these names. For more information, see the Best Practices for Managing Your Assets with HP Web Jetadmin white paper. This white paper is available from the HP Support Center.

20. Media size configuration is now available for HP P2055, P3015, and CP3525 device models.

21. A device configuration option in the Copier category named Default Copy Output Media Size is now named Default Original Media Size.

22. A device configuration option in the Copier category named Mixed LTR/LGL has been added for several devices, including the HP LaserJet M4345 MFP.

24. The **Import Firmware Images** option is now checked by default in the **Get Images** wizard in **Firmware Repository**.

25. In the **Send To Network Folder** FTP setup, the backslash (\) is now allowed in the **User Name** field.

26. For **Digital Sending**, the **Default From Address** configuration now updates devices correctly.

27. HP Web Jetadmin now correctly detects .NET Framework Service Patch versions at installation time.

### HP Web Jetadmin 10.2 SR2 (10.2.63313)

The following are the improvements and fixes made in HP Web Jetadmin 10.2 SR2 (10.2.63313):

1. HP Web Jetadmin (server application HPWJA) is now supported on Microsoft Windows 64-bit operating systems. For more information about the requirements, see the **HP Web Jetadmin 10.2 Installation and Setup Guide**.

2. The HP Web Jetadmin installer has had many improvements, but remains essentially the same.
   - Some issues might occur if your system is running with minimal disk space.
   - The minimum disk space for HP Web Jetadmin has increased to 6 Gigabytes.
   - The installer now requires that you have Microsoft Windows Installer 4.5.
   - The **Install log** has changed, but it is still written to the user’s temp directory: %tmp%.
   - The HP Web Jetadmin client is not yet released as a 64-bit application, but is supported as a 32-bit application on supported 64-bit Microsoft Windows operating systems.

3. HP Web Jetadmin 10.2 now contains a new configuration item named **Duplex Impressions**. Duplex Impressions is a device feature found in newer HP device models and firmware. This feature changes the way in which the HP device counts printed pages to align with a new page counting methodology. The configuration item is a ONE TIME CHANGE that cannot be reversed on the device after it has been set. For more device-specific information, go to [www.hp.com/go/support](http://www.hp.com/go/support). To navigate to the support web page for your product, on the **Support & Drivers** page, type the product name of your device (for example, HP Color LaserJet CM3530 MFP or model number CC530A) in the See support and troubleshooting information for product section. After you find the correct support page, search for “Print Tracker Usage”.

4. In **Alerts**, device address information in custom email formatted messages no longer intermittently appears labeled **Unknown**.

5. Improvements in **By-user Data Collection** performance might vary by implementation. At this time, HP does not publish HP Web Jetadmin performance details.

6. **Alert Subscriptions** no longer appears for devices that have been removed from the HP Web Jetadmin **All Devices** list. The subscription settings are cleared for any device that is no longer part of the system.

7. The **Analog Fax** column in device lists now correctly displays device capability when the device is on or off the network.

8. The **Specified Address** import feature now correctly detects and sends a notification for incorrect IP address formats.

9. When the **By User Reports** are grouped by user, they now correctly show user names rather than showing **Unknown**.

10. Improvements to **Firmware Upgrade** now allow same-version upgrades without having to configure the software to downgrade firmware.
11. A Cover Open condition at the device no longer causes HP Web Jetadmin to falsely generate Supplies Alerts on all HP devices.


13. It is now possible to multiselect when qualifying firmware images.

14. Improvements have been gained on some configuration items where the previous release prompted for SNMPv3 credentials. Several configuration items no longer prompt for SNMPv3.

15. In Data Collections, time zones are only displayed if they are present on both the HP Web Jetadmin server and HP Web Jetadmin client. Data Collection component problems occur when there is a difference between these two lists. HP Web Jetadmin always displays the time zone text as it is available from the client desktop.

16. General Alerts are now unblocked for all non-HP devices. General Alerts are established with HP device object support as a primary consideration. Some of these Alerts, such as Toner Low and Toner Out, do work for a number of non-HP devices. Customers should check with non-HP device vendors to understand device manageability because HP Web Jetadmin does not work with all non-HP devices in the same way. These variations are due to device management object differences.

17. The device list Export feature now correctly omits comma separators from all numeric values.

18. A user-defined configuration now functions correctly on all devices.

19. Envelope feeder now appears correctly as a capability.

20. The serial number for most non-HP printers is now processed correctly, allowing users to block these devices from Discovery.

21. In Supplies, Group By: Urgency now provides a correctly sorted list.

22. In Data Collections, the In Progress status is currently reset as the data collection completes. Earlier releases displayed the In Progress status even when data collections were not completing properly.

23. The Solutions Repository now shows item description fields.

24. Firmware versions are now represented correctly on devices when earlier versions of HP Web Jetadmin had the Use Qualified option set under Tools > Options.

25. Firmware upgrade scheduling is now possible on all firmware upgrade paths.

26. Configuration items for the MFP device configuration are now correctly populated for newer firmware versions. HP Web Jetadmin performs limited firmware revision checking for some configuration elements, such as DSS Configuration.

27. Logic improvements in Supplies alerting and polling prevent missed threshold messages. One notification is triggered each time a supply level changes through a specified threshold. A replenish event is set any time the supply level increases by 30% or more. A replenish event causes remonitoring of specified levels triggering new supply threshold messages.

28. Supplies for most non-HP devices now have their names reflected correctly by HP Web Jetadmin. Older versions incorrectly showed supply naming due to ordering differences in device-based objects.

**HP Web Jetadmin 10.2 SR1 (10.2.62227)**

The following are the improvements and fixes made in HP Web Jetadmin 10.2 SR1 (10.2.62227):
1. Reports might now contain the error message: **No data retrieved for the selected devices in the specified time period.** For large reports where data is expected, try increasing the database query timeout option.

2. **Data Collection Anomalies** are now limited to 10,000 entries. Attempting to display large lists of anomalies caused **Unexpected** errors in earlier releases of HP Web Jetadmin 10.2.

3. Scheduled data synchronizations with other HP Web Jetadmin servers now complete successfully.

4. The **Search** feature in **Help** now yields results correctly.

5. The **Delete** option now works correctly for reports archived before 2008.

6. The **Edit Discovery Template** feature now displays correctly and allows control over credential settings.

7. Upgrading from HP Web Jetadmin 10.1 now creates a **Specified Address Group** based on the address list present in the earlier HP Web Jetadmin release.

8. Upgrading from HP Web Jetadmin 10.1 now correctly retains **Specified Address** discovery settings from templates used in the earlier HP Web Jetadmin release.

9. **Specified Address** discovery details are now displayed correctly for discoveries run in HP Web Jetadmin 10.2.

10. Group Policies are now applied correctly to existing devices at the time the policy setting is activated in HP Web Jetadmin.

11. A migration from HP Web Jetadmin 8.x now correctly migrates all supplies threshold alerts subscriptions.

12. **Device Utilization** reports now correctly reflect **Mono Simplex** counts for HP Color LaserJet 3600, 4500, 4600, and 5500 devices. Previously, these devices did not have mono simplex reflected correctly on HP Web Jetadmin reports.

13. Outgoing fax counts in HP Web Jetadmin device list columns and reports now appear for a number of devices. Previously, these counters did not appear correctly.

14. Devices replaced in existing device IP addresses where the older devices had been present in HP Web Jetadmin Data Collections no longer have data collections performed. These devices are qualified as new, unique devices and can have Data Collections settings established, but are no longer considered the same device due to being located at an older device's IP address.

15. SNMP Trap payload (from HP Web Jetadmin **Alerts**) now contains device details when HP Web Jetadmin can acquire these details. Previously, these trap packets could contain **Unknown** even when the device was on the network.

16. In HP Web Jetadmin **Reports**, the Outgoing Fax pages are now correctly reflected for many devices. Previously, these could incorrectly display a value of ****.

17. The HP OfficeJet Pro now shows the correct counts for **Total Engine Cycle** in device list columns and HP Web Jetadmin reports.

18. **Secure Storage Erase** now functions correctly on many HP DesignJet models.

19. A new device configuration object has been added: **Clear Send to Network Folder Settings**. This object provides a configuration path to change **Send to Network Folder Settings**. A new and different **Send to Network Folder Settings** configuration item is planned for a future release of HP Web Jetadmin that allows settings such as **Folder Path** to be changed and managed. However, for the interim, **Clear Send to Network folder** must be used along with configuration templates to manage **Send to Network Folder** settings. Help will be provided that covers this in great detail.

**ENWW Improvements and fixes in previous Service Releases of HP Web Jetadmin**
20. There is now full localization in Alerts emails generated in non-English.


22. In Print Management:
   – The UPD version 5.0 driver upload now functions properly.
   – The Create Print Queue function succeeds with version 5.0 UPD driver.

![NOTE:](image) The remote server must have print queue or print share functionality enabled. See the Microsoft documentation to enable or share print queues on Microsoft Windows.

23. Users no longer lose the ability to view HP Web Jetadmin Maps. Some user behavior in addition to HP Web Jetadmin client cache behavior could cause Maps to disappear from view within HP Web Jetadmin. These issues have been fixed.

24. Non-HP devices that support standard objects for control panel display are now shown with control panel display text in HP Web Jetadmin status and other features that convey this information.

25. Default Copy options within Configuration now support Auto Detect Mode.

26. The HP Web Jetadmin Import configuration feature now accepts data wrapped in quotes that contains a comma in the configuration CSV file.

27. Improvements have been made to the Home page for HP CM3530 MFP devices for configuration items.

28. Device graphics now update correctly after an HP Web Jetadmin version upgrade with related specific device support is performed.

29. Configuration Templates now store and retain the Custom Media name detail correctly.

30. The NFS Access column now correctly shows Yes or No according to the device capability. The incorrect functionality showed Enabled or Disabled. The Enabled or Disabled detail will be available in a future release of HP Web Jetadmin when this new column will be introduced.

31. The HP Web Jetadmin Status tab now shows correct control panel text for devices that are set to display in Finnish.

32. Firmware downloads through secure proxy are now possible.

33. The HP DesignJet 1055CM Status tab graphic is now displayed correctly.

34. The HP CP3525 (and other models) Cover Open condition no longer triggers Supplies Alerts.

35. The EWS Mail Server configuration object now allows FQDN in addition to IP address.

36. The Fax Baud configuration object is now set correctly on devices that support this feature.

37. Upgrades in previous revisions could stop on stored or unfinished tasks. This issue has been corrected.

38. The PJL file repository now accepts new files after an upgrade from HP Web Jetadmin 10.1.

39. The Configure Date/Time option now uses the server time as the base and allows the administrator to specify an offset of hours and minutes. This ensures that the date and time are configured accurately on devices in both single and batch modes.

**HP Web Jetadmin 10.2**

The following are the improvements and fixes made in HP Web Jetadmin 10.2:
1. Outgoing Fax Counts now appear correctly in Device Utilization Reports.

**NOTE:** Some device-specific issues still exist.

2. The HP Web Jetadmin Service (HPWJA Service) startup fails. Upgrades over 10.1 with the HP Web Jetadmin version 10.2.58560 installer (hpwja_setup-102-58560.exe) might fail in some cases. The HP Web Jetadmin application installs correctly the first time and runs normally until a reboot or the HPWJA Service is restarted. At this point, all service startups fail. This issue is fixed in the latest HP Web Jetadmin 10.2 release.

3. The HP Web Jetadmin Data Collection feature no longer allows data collection to take place on a new device that has been placed on the network at an IP address that was registered to a different device (one that is not present on the network). HP Web Jetadmin now fails the collection for this device. The new device, when added to Data Collection, is added as a different and newer device.

4. The Time Zone drop-down list no longer duplicates itself in multiple configuration mode when the user selects an option and then deselects it.

5. The Fax Number now appears correctly in the column for devices that have one set.


7. Input Trays on third-party devices now show the correct capacities.

8. The HP Color LaserJet CM6040 MFP Cover Open message no longer forces Supplies Alerting.

9. Duplicate Alerts are no longer propagated as devices are added and removed from device groups that have Alerts policies.

10. When selecting the Embedded Web Server folder on the Config tab on Device lists for the HP LaserJet 9040 and 9050 printers, the Error Reading Device Settings message is no longer displayed.

11. The System Name option now appears when using the Import from file option under Configure Devices.

12. In Reports, duplicate entries are no longer included in the Event Log History report.

13. The client no longer crashes when working in the Alerts area.

14. For the HP Color LaserJet CM6030 and CM6040 devices, the System Contact object no longer uses the Contact Person object.

15. Configuring Supplies Alerts are no longer triggered when deleting or rediscovering a device.

16. Configuring Device Link Settings no longer causes other device configuration conflicts.

17. Device Data Collections are no longer treated as Partial when a non-default collection time (other than 12:00 am) is used.

18. Reports now show Outgoing Fax Counts.

19. HP OfficeJet devices now display supplies correctly in columns.

20. The interim report count of Total Color Pages now appears correctly for the HP Color LaserJet CM2320fxi MFP.

21. The HP Color LaserJet 9500 MFP now displays accurate values for the Total Color Page Count column in device lists.

22. Brother printers now correctly display Model Name.

24. Protocol settings are now completed at the end of a configuration process in order to avoid conflicts with other configuration settings.

25. The Disable reverse DNS lookup field now appears correctly in the Kerberos configuration section.

26. If you are configuring the Send to Network folder path with a duplicate folder name in a Configuration template, a Duplicate folder error message is now displayed.

27. When performing Data Synchronization with other HP Web Jetadmin servers, User Defined values now correctly synchronize from the source host.

28. The Severity icon for third-party devices is now displayed correctly.

29. For Fax Printing, the PIN can now be configured with a leading zero character.

30. In the Digital Sending folder, you can now configure email settings on the HP LaserJet M and CM series devices for the following:
   - Use Address Book entries only
   - Default Subject
   - Default File Name

31. The HP SNMP Proxy now checks to ensure the SNMP Service is installed before it installs.

32. On the Troubleshoot tab under the Device list, the HP Support link now successfully displays the appropriate product page for the device.

33. Third-party printers that do not show a serial number can now be added to the Device Utilization Data Collection process for Reports.

34. Renaming an Alerts Subscription template no longer causes the template to be removed from its associated Group Policy.
Improvements and fixes in previous Feature Pack releases of HP Web Jetadmin

Feature Pack 12 (version 1.12.109083)

Feature Pack 12 (version 1.12.109083) contains the following new functionality and fixes:

1. CR 12663: The following XTP tickets have been added:
   - Celiveo_DateVersion_ReadOnly_FS.zip.HPb
   - Celiveo_RevisionVersion_ReadOnly_FS.zip.HPb
   - E50045_E55040_fwUpgradePreparationSolution_DateVersion_ReadOnly_FS.zip.HPb
   - HPEC_DateVersion_ReadOnly_FS.zip.HPb
   - HPEC_RevisionVersion_ReadOnly_FS.zip.HPb
   - IP_Fax_Operation_ECM_ReadWrite_FS.zip.HPb
   - IP_Fax_Operation_FaxSendSpeed_ReadWrite_FS.zip.HPb
   - IP_Fax_Operation_FaxSendSpeedReadOnly_FS.zip.HPb
   - IP_Fax_Operation_FaxSendSpeedReadOnlyLarge_FS.zip.HPb
   - Papertype_Tray1_ReadWrite_FS.zip.HPb
   - Papertype_Tray2_ReadWrite_FS.zip.HPb
   - Papertype_Tray3_ReadWrite_FS.zip.HPb
   - Papertype_Tray4_ReadWrite_FS.zip.HPb
   - Papertype_Tray5_ReadWrite_FS.zip.HPb
   - Papertype_Tray6_ReadWrite_FS.zip.HPb
   - SkipInitialSetupWizard_ReadWrite_FS.zip.HPb

2. REQ 7364: The Restart Device Immediately configuration option has been added to the device category for the HP PageWide XL/HP Designjet MFP UPI 6+ Colors.

3. REQ 7365: The Secure File Erase configuration option has been added to the File System Category for HP PageWide XL/HP Designjet MFP UPI 6+ Colors.


5. REQ 7378: HP Web Jetadmin is now displaying in the licenses column all installed device licenses which are listed on the device license URL.

**NOTE:** Feature Pack 12 is pre-bundled with HP Web Jetadmin 10.4 SR7 and can be installed on HP Web Jetadmin 10.4 SR5 and later. Installation on older HP Web Jetadmin versions is not supported and has not been tested by HP.

Feature Pack 11 (version 1.11.106528)

Feature Pack 11 (version 1.11.106528) includes the following new functionality and fixes:

1. REQ 7051: The configuration option “Fax Receive Job Owner” has been added to HP Web Jetadmin for all FutureSmart devices. This option is available under the Fax category and is not configurable via the EWS.

2. REQ 7060: Added the ability to filter on the actual Active Ciphers, like AES246-SHA. The Active Cipher is a sub-entry of the configuration setting Secure Communication.

3. CR 12336: Added the device picture for HP Color LaserJet flow E87640.

4. CR 12338: Added the device picture for HP Pagewide ES8650.
5. CR 12355: The configuration option **SNMP Credentials FutureSmart 4** checkbox is now displaying that the password complexity is enabled for the SNMPv3 configuration. The option remains greyed out as it currently cannot be changed via HP Web Jetadmin.

6. CR 12365: The configuration option **Upload ID Cert** under the **Network** category is now also available for the HP LaserJet Pro NIC.

7. CR 12372: The configuration option **Enable Fax Receive** has been renamed into **Fax Receive (enable/disable)**

8. CR 12428: The following XTP tickets have been added and are visible in the XML repository when Feature Pack 11 is installed on HP Web Jetadmin 10.4 SR5 or later:

   - Fax-Confirmation_AdvancedFaxSettings_Read-LEDM.zip.HPb
   - Fax-Error-Report_AdvancedFaxSettings_Read-LEDM.zip.HPb
   - FaxReceive_Read_FS.zip.HPb
   - Fax_ConsolidatedPrintedReports_Read_FS.zip.HPb
   - Fax_PromptUserPriorToJobStart_Read_FS.zip.HPb
   - PaperCut_DateVersion_READ_FS.zip.HPb
   - PaperCut_RevisionVersion_READ_FS.zip.HPb
   - ThinPrint_DateVersion_READ_FS.zip.HPb
   - ThinPrint_RevisionVersion_READ_FS.zip.HPb
   - Troy_DateVersion_READ_FS.zip.HPb
   - Troy_RevisionVersion_READ_FS.zip.HPb

9. CR 12360: The maximum number of concurrent threads for configuration tasks has been increased from 5 to 10. Ten devices can now be configured simultaneously.

10. CR 12454: The **IPSec/firewall** template now supports variable data for the local and remote IP addresses.

11. **REQ 7177:** HP Web Jetadmin can now display the licenses that are installed on a device and show the remaining licensed days in the new column option—**Licenses**.

12. **REQ 7250:** Added the configuration option **Time Services** under **Embedded Web Server** category for HP Pagewide XL UPI/HP DesignJet (MFP) UPI 6+ Colors.

13. **REQ 7251:** Added the configuration option **SMTP Server and Alert Settings** under the **Digital Sending** category for HP Pagewide XL/HP DesignJet (MFP) UPI 6+ Colors.

14. **REQ 7252:** Added the configuration option **LDAP Settings** under the **Digital Sending** category for HP Pagewide XL/HP DesignJet (MFP) UPI 6+ Colors.

15. **REQ 7254:** Added the configuration option **Windows Sign In Setup** under **Security** category for HP Pagewide XL/HP DesignJet (MFP) UPI 6+ Colors.

16. Device images were added for the following devices:
   - HP PageWide E58650
   - HP PageWide Enterprise Color MFP 586
   - HP PageWide Managed Color Flow MFP E58650z
   - HP Color Laserjet MFP E77422
   - HP Color Laserjet MFP E77428
   - HP Color Laserjet E50145
   - HP Color Laserjet MFP E72425
Feature Pack 10 (version 1.10.105724)

Feature Pack 10 (version 1.10.105724) includes the following new functionality and fixes:

1. **REQ 6853**: Added configuration option for Bluetooth Low Energy for FutureSmart devices under the Security category.

2. **REQ 7028**: Added support to enable HP Web Services to connect the device to HP Connected on the web under the Web Services category.

3. **REQ 7086**: Added configuration option for APL Enable on Zebra devices.
4. REQ 7118: Added configuration option Home Screen Customization (FutureSmart) under the Device category.

5. REQ 7120: Added the configuration option PS Privileged Operators under the Security category.

6. CR 12186: Renamed configuration option from Show Stop Button to Show Cancel Job Button.

7. REQ 7155: Added the configuration options to enable/disable Web Services for the HP DesignJet T3500.

8. REQ 7129: Added the following configuration options for the HP DesignJet T3500:
   - Printer Utility (enable/disable)
   - Color and Paper Management (enable/disable)
   - Scanner SDK (enable/disable)

9. REQ 7087: Added support to display in column status for Print Paper Out (Zebra).

10. REQ 7186: Print speed configuration option changed to a text box instead of a drop-down box (Zebra).

11. CR 11984: An XTP ticket to show the user-friendly FutureSmart version is now available under the XML repository and can be used. See the whitepaper: HP WEB JETADMIN—USE XML TICKETS.

12. REQ 7141: Cross-site Request Forgery (CSRF) Prevention (Security) configuration is now also possible for FutureSmart 3.

13. REQ 6955: Added support for Feature Packs to install signed XML files in a HP Web Jetadmin directory. The following XTP tickets are pre-installed and visible when HP Web Jetadmin is running under the Network service Account:

    Note: After changing from Network Service to a user account and restarting the HP Web Jetadmin service, the pre-bundled XTP tickets are not visible. Contact HP support to obtain any of the listed XTP tickets when HP Web Jetadmin needs to be running under a user account.

   - Equitrac_DateVersion_READ_FS
   - Equitrac_RevisionVersion_READ_FS
   - FutureSmartBundleVersion_READ_FS
   - HPAC_DateVersion_READ_FS
   - HPAC_RevisionVersion_READ_FS
   - Safecom_DateVersion_READ_FS
   - Safecom_RevisionVersion_READ_FS
   - USBAccessory1_READ_SNMP
   - USBAccessory2_READ_SNMP
   - AllFirmwareUpdates-AdministratorSettings-Enabled_LEDM
   - AutoOffAfterSleepTimer_READ_FS
   - DefaultRetainSetting_Copy_Read_FS
   - DisplayInformationIcon_READ_FS
- HP_Connection_Inspector_Cumulative_Protected_Mode_Duration_SNMP
- HP_Connection_Inspector_DNS_Failure_Threshold_SNMP
- HP_Connection_Inspector_Monitoring_Window_SNMP
- HP_Connection_Inspector_NumberOfTimes_in_Protected_Mode
- HP_Connection_Inspector_Protected_Mode_Duration_SNMP
- HP_Connection_Inspector_Status_SNMP
- HPInstantSupportLink_READ_FS
- KeyboardSound_or_SystemSound_READ_FS
- LowWarningThreshold_READ_FS
- OXPD_Service_read_write_SNMP
- PCL_Font_Number_READ_FS
- PCL_Font_Point_Size_READ_FS
- PCL_Orientation_READ_FS
- PCL_Symbol_Set_Read_FS
- PrintQualityLevel_READ_FS
- RestrictColorUse_READ_FS
- ServiceFluidContainer_READ_FS
- Show_Help_Button_Read_FS
- Tray1X1Shift_READ_LEDM
- Tray1X2Shift_READ_LEDM
- Tray1Y1Shift_READ_LEDM
- Tray1Y2Shift_READ_LEDM
- Tray2X1Shift_READ_LEDM
- Tray2X2Shift_READ_LEDM
- Tray2Y1Shift_READ_LEDM
- Tray2Y2Shift_READ_LEDM
- Tray3X1Shift_READ_LEDM
- Tray3X2Shift_READ_LEDM
- Tray3Y1Shift_READ_LEDM
- Tray3Y2Shift_READ_LEDM
- Tray4X1Shift_READ_LEDM
See the *Use XML Tickets with HP Web Jetadmin* whitepaper for further instructions on about XTP tickets or use the HP Web Jetadmin online help.


15. CR 11860: The SNMPv3 credentials column no longer shows the value *SET_NoMatch* when HP Web Jetadmin has the correct SNMPv3 credentials for the device.

16. REQ 7244 (CR 12014/11951): When a device is in SNMP read-only mode and a user tries to configure a setting over SNMP, HP Web Jetadmin will prompt for SNMP Credentials. The *Enter SNMPv1 Set Community Name* screen will now inform the user that HP Web Jetadmin has the wrong SNMP set community name or SNMP set operations have been disabled on the device.

17. CR 11755: SNMP v3 credentials now have a separate checkbox and remain greyed out if not selected in SNMP credentials for FutureSmart 4.5 devices.

18. CR 11873: The name of the *Strong Signature Validation* configuration option in the *Security* category has been changed to *Extended Signature Validation*.

19. CR 12187: The HP Connection Inspector screen now explains that XML tickets are available for additional settings under the security category.

20. CR 11967: HP Web Jetadmin is no longer prompting for EWS credentials after successful configuration of enabling /disabling of the Embedded Web Server password Settings feature.

**Feature Pack 9 (version 1.9.104496)**

Feature Pack 9 (version 1.9.104496) contains the following new functionality and fixes:

1. REQ 6614: Default Retain Settings Behavior (Security)—Added support to change the options for each job type.

2. REQ 7057: Home Screen Customization (Device, Pagewide Pro)—Added support to remotely add or remove control panel icons on the printer Home screen

3. REQ 6585: Certificate Validation (Security)—The configuration option has been added, including the possibility to set Online Certificate Status Protocol (OCSP) URLs.

4. REQ 7075: Smart Cloud Print (Web Service)—Added support for users to access web-based applications that extend the capabilities of the device.

5. REQ 7077-7085: Added support for the following items for Zebra devices:
   - Darkness (Device)—Create lighter or darker print.
   - Print Speed (Device)—Set the device print speed.
   - Media Type (Device)—Continuous and non-continuous media.
– Print Mode (Device)—Select the action the device takes after a label or group of labels has printed.
– Print Method (Device)—Select the appropriate print method associated with media type.
– HTTP Enable (Device)—Enable or disable HTTP communications
– SMTP (Network)—Enable or disable the SMTP email protocol.
– POP3 (Security)—Enable or disable the POP3 email protocol.
– Display Language (Device)—Select the language used on the control panel.

6. CR 11873: Extended Signature Verification (Security)—Renamed Strong Signature Validation to Extended Signature Validation.

7. CR 11869: The Quick Set settings for a Save to USB Quick Set for a PageWide Pro device is no longer removed when editing an existing template.

8. CR 11870: When applying a Quick Set configuration to an HP PageWide Pro device, Success is displayed in the results window. Previously, Error was displayed when the setting was applied correctly.

9. CR 11872: While sending a template with multiple configuration settings to a device over SNMPv3, the results window displays Success. Previously, Error or Not supported was displayed when the setting was applied correctly.

10. CR 11894: Show Welcome Message and IPV6 configuration are no longer failing while sending a template that contains those settings and the SNMPv3 configuration.

11. CR 11907: When configuring a FutureSmart device with a template that contains the Bootloader Password, EWS password, and SNMP 4.5 Configuration in template mode, the configuration will now end successfully.

12. CR 11909: HP Web Jetadmin is no longer prompting for the EWS password when sending a configuration file with multiple settings.

13. CR 11911: While editing a template that contains a wallpaper, the wallpaper setting is not lost when saving the changes.

14. CR 11895/CR 11928: The keep as is status for the Home Screen Applications configuration option on FutureSmart 4 devices is now saved correctly in a template.

15. CR 11455: Email File Settings under the digital sending category on the configuration tab on HP PageWide Pro 477-577 devices are no longer missing (randomly).

16. CR 11851: Device picture no longer missing for HP PageWide Managed Color P75270DN.
Feature Pack 8 (version 1.8.104107)

Feature Pack 8 (version 1.8.104107) contains the following functionality:

3. REQ 6983: Under the security category, the configuration option Manage Remote Apps has been added.
4. REQ 6999: Under the security category, the configuration option Cross-Origin Resource Sharing has been added.
5. REQ 7044: The configuration option Quicksets (FP) for the HP PageWide Pro(MFP) UPI supports user variable da
data for UNC Folder Path, User name, Default display name, Subject, Message, and SharePoint Path.

Feature Pack 7 (version 1.7.103363)

Feature Pack 7 (version 1.7.103363) contains the following functionality:

1. REQ 6876: Added Backup configuration option under the Device category. This option creates a backup of a FutureSmart printer.

   **NOTE:** To restore the printer backup, use the Restore option under the Troubleshooting tab in HP Web Jetadmin.

   **NOTE:** If the user credentials are incorrect, a success message displays even though no backup has been created. This will be fixed in Feature Pack 8 (CR 11594).

2. REQ 6952: When applying templates with Home Screen Applications – FutureSmart 3 or 4 to different devices, the printer icons create correctly.

3. REQ 7015: Added Strong Signature Verification configuration option under the Security tab for FutureSmart devices. If enabled, the device will validate during installation and during load if the solution (including all individual dlls) has been signed by HP. If disabled, the device will check during installation if the solution has been signed by HP. Currently, this feature is not available in the EWS.


5. CR 11595: Smart UX has been renamed to HP JetAdvantage Link under the Security category. In single device mode, the option will now also show the active HP JetAdvantage Link status. When changing the link status in HP Web Jetadmin, the active link status will only change after a reboot. The device will not reboot automatically in order to avoid interruption.

6. CR 11531: In single device mode, the Enable Online Solutions for FutureSmart 4 devices option under the Online Solutions configuration option is greyed out. This is no longer configurable on FutureSmart 4 devices, because it is always enabled.

7. CR 11564: The following application names have been changed in the Home Screen Applications – FutureSmart 4 configuration option to match changes in the EWS:
   - Job status changed to Job Log (FS 3: Job status)
   - Administration changed to Settings (FS 3: Administration)
   - Device Maintenance changed to Support Tools (FS 3: Device Maintenance)
8. CR 11571: When creating or editing a template with the Quick Sets configuration option for PageWide devices, all quick sets display in HP Web Jetadmin.

9. CR 11584: Copy and paste operations are now working for the Quick Sets configuration option.

10. CR 11586: Added device images for HP PageWide Managed Color MFP Exxxxx models.

11. CR 11599: The Online Solutions configuration option is no longer missing when editing an existing template.

12. CR 11609: Templates with settings for the Quick Sets configuration option retain the settings correctly.

**Feature Pack 6 (version 1.6.103289)**

Feature Pack 6 (version 1.6.103289) contains the following fix:

- CR 11592: Home Screen Applications - FutureSmart 4 configuration option missing in templates that have been upgraded to the initial Feature Pack 6 release (version 1.6.103055). After installing the updated Feature Pack 6, the configuration option will be listed again in the upgraded templates.

Feature Pack 6 (version 1.6.103289) also contains the following functionality from the initial Feature Pack 6 release (version 1.6.103055):

1. REQ 6807: Added configuration option “Home Screen Wallpaper Customization” to the Device category for HP Enterprise UPI and HP Enterprise MFP UPI.

2. REQ 6797: Added the configuration option “Enable PJL Device Access” and “File System External Access” to the PageWide Pro UPI and PageWide Pro MFP UPI.

3. REQ 6799: Added “Overwrite existing values and Append” to existing options for the Control Panel Shortcuts configuration of the PageWide Pro and PageWide Pro MFP UPI.


5. REQ 6852: Added the configuration option “Dust Detection” to the Device category for FutureSmart MFP devices. Dust Detection can improve scanning quality.

6. REQ 6873: Added the configuration option “Sheets Folded Together” under the Copy Manage Booklet option in the Copy category for FutureSmart devices.

7. REQ 6897: Added configuration option to enable/disable HP Connection Inspector (DNS Anomaly Protection) under the Network category. This function is available on FutureSmart devices with FutureSmart bundle version 4.5 and later.

8. REQ 6918: Added the option Smart UX Apps to enable/disable running Smart UX apps on the device. It requires the android bundle support on the device.

**NOTE:** Due to some firmware changes, an update to the Smart UX configuration option will be available in Feature Pack 7 (December 2017). This update (CR 11563) will be required for the Smart UX configuration.

9. REQ 6920: Enable Online Solutions option is greyed out in single device mode for FutureSmart 4 devices. FutureSmart 4 devices have this option always enabled.

**NOTE:** In future Feature Pack releases, this will be greyed out with the check box selected.
10. REQ 6921/6922/6927: Added the HP PageWide Pro MFP UPI and HP PageWide Pro UPI to the configuration option Default Print Options under the Device category and added Output Bin under Default Print Options.

11. REQ 6923: Added the HP PageWide Pro MFP UPI and HP PageWide Pro UPI to the configuration option Local Administrator Password under the Security category.

12. REQ 6936: Added configuration option SNMP Credentials (FutureSmart 4.0) and renamed SNMP Version Access Control to SNMP Credentials (FutureSmart 3.0 and non-FutureSmart devices) for FutureSmart 4.5 devices that will have SNMPv1 set to read-only. In order to change the SNMP settings on the device, HP Web Jetadmin will be using a different protocol (CDM) to configure SNMP settings on the device. SNMPv1 can be re-enabled without having to configure SNMPv3 first with the SNMP Credentials (FutureSmart 4) configuration option.

After discovering a factory new FutureSmart 4.5 device (or an upgraded device that has been set to factory defaults), it requires configuring the SNMP settings on the device before any other SNMP managed settings can be changed.

Feature Pack 6 is required to reconfigure the new Secure by Default settings. New templates and workflows have to be created (first configure snmp before configuring other options).

It’s also recommended to use as a minimum HP Web Jetadmin 10.4 SR2 as SR2 contains an important fix wrt switching communication between SNMPv1/v2 and SNMPv3.

HP Web Jetadmin 10.4 SR2 with Feature Pack 6 is the minimum for the secure by default settings.

For more information, see the Discovering and Configuring FutureSmart Devices Version 4.5 and Later whitepaper.

13. REQ 6936: Added a textual message to the Install button to inform users that PJL has to be enabled under File System External Access in order to install Fonts and Macros.

**NOTE:** The message and configuration option will be updated in 10.4 SR4 to match the EWS.

14. Another change with the Secure by Default settings in FutureSmart 4.5 is that Cross-Site Request Forgery prevention is enabled to prevent web-scraping. Currently, HP Web Jetadmin does not have a UI option to change this setting and an XTP ticket will be required to change it. HP Web Jetadmin is not affected by this setting.

15. REQ 6940: HP Web Jetadmin offers more colors and Color Intensity for the option Show Welcome Message.

16. REQ 6957: Added configuration option Paper Path under Copier Category for FutureSmart devices.

**Feature Pack 5 (version 1.5.101720)**

Feature Pack 5 (version 1.5.101720) contains the following functionality:

1. REQ 6580: Added Estimated Supplies Levels configuration option under the Supplies category for LEDM devices.

2. REQ 6644: The AirPrint Secure Scan settings has been added to the Network Enable Features - More Settings configuration option under the Network category.

3. REQ 6117: Energy Settings have been added for HP LaserJet Pro MFP UPI under the Device category.

4. REQ 6771: Service Access Code configuration has been added for PageWide devices under the Security category.
5. REQ 6790: Support for new ciphers for FutureSmart 4 devices with the Secure Communications option under the Security category.

6. REQ 6762/6772: Support for new (Default) Media Types and (Default) Media Sizes for PageWide devices.

7. REQ 6764: Device Certificate configuration has been added for PageWide devices.

8. REQ 6765: Added support for B4 media size for PageWide devices.

9. REQ 6766: HP JetAdvantage (More Apps) can now be configured with PageWide Pro/OfficeJet Pro MFP UPI.

10. REQ 6844: Added Copy Watermark and Copy Watermark (Custom) under Copier Category for HP Enterprise MFP UPI.

11. REQ 6845: Added Copy Stamps, Copy Stamps (Custom) and Copy Stamps (Enforced) under Copier category for HP Enterprise MFP UPI.

12. REQ 6846: Added Copy Manage Booklet under Copier category for HP Enterprise MFP UPI.

13. REQ 6847: Added Copy Fold under Copier Category for HP Enterprise MFP UPI.

14. REQ 6851: Added Copy Staple/Hole Punch under Copier category for HP Enterprise MFP UPI.
Help and resources for HP Web Jetadmin

- Online Help
- Resources on www.hp.com
Online Help

The HP Web Jetadmin online Help provides detailed information about using the software to configure and manage devices on the network. To access the online Help, go to Help > Context help. Use the Contents, Index, and Search tabs to navigate the online Help.

Each page in HP Web Jetadmin has a help icon (?) on the content toolbar. When you click the help icon and then click somewhere on the page, HP Web Jetadmin displays context-sensitive help for that specific portion of the page. Context-sensitive help provides only the information you need for the displayed page or option.

NOTE: To access external links, the browser must have access to the Internet. If you are behind an Internet firewall, you might need to configure proxy servers. Consult the network administrator to determine the appropriate settings for the browser.
Resources on www.hp.com

- **HP Web Jetadmin product page** ([www.hp.com/go/webJetadmin](http://www.hp.com/go/webJetadmin)): Contains links to information about the value and benefits of HP Web Jetadmin, including the following:
  - HP Web Jetadmin brief
  - HP Web Jetadmin white papers and other important documentation
  - Other value-added details

- **HP Web Jetadmin at Software Depot**: Provides overview, installation, and support details for the HP Web Jetadmin software and associated utilities. Detailed information includes the following:
  - Links to critical support documentation as well as other HP portals associated with this software
  - Links to the Extended Modules licensing pages
  - A Select link to acquire the HP Web Jetadmin software and related utilities

- **HP Support**: As with all HP products, HP Web Jetadmin is supported by trained support staff. To learn how to contact HP Support in your country/region, visit the HP Support pages at [www.hp.com/support](http://www.hp.com/support).

- **HP Web Jetadmin Premium Support product**: HP is pleased to announce HP Web Jetadmin Premium Support. This is a for-fee support service that offers you direct access to HP Web Jetadmin Support Specialists. For more information, browse to [www.hp.com/go/webJetadmin](http://www.hp.com/go/webJetadmin), and click the Web Jetadmin Premium Support link.